HeartStart 12-Lead Transfer Station

USER GUIDE

Edition 1
About This Edition
Publication date: May 2008
Version: 3.0
Part Number: 012976-0004
Printed in USA
Philips Healthcare shall not be liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of the material.

Copyright
Copyright © 2008
Philips Electronics North America Corp.
No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any human or computer language in any form by any means without the consent of the copyright holder.
Unauthorized copying of this publication may not only infringe copyright but also reduce the ability of Philips Healthcare to provide accurate and up-to-date information to users and operators alike.

Warranty
Philips Healthcare makes no warranty of any kind with regard to this material, including, but not limited to, the implied warranties or merchantability and fitness for a particular purpose.

Trademarks
MRx Defibrillator/Monitor, and the HeartStart logo are either registered trademarks or trademarks of Koninklijke Philips Electronics N.V.
Bluetooth wordmark and logo s are either a Bluetooth SIG, Inc. The Bluetooth wordmark and logos are owned by Bluetooth SIG, Inc.
DatamedFT is a registered trademark of Engineering Solutions, Inc.
Microsoft, Windows, .NET Framework, Outlook, Pocket PC, and Internet Explorer are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
PDF is a registered trademark of Adobe Systems, Inc.
Yahoo is a registered trademark of Yahoo, Inc.

Caution
Federal Law (USA) restricts this device to sale by or on the order of a physician.
This product is not intended for home use.
Displayed and faxed waveforms may not meet the requirements of American National Standard ANSI/AAMI EC11:1991 for display of diagnostic electrocardiograms, and may not be suitable for diagnosis.

Authorized EU Representative
Philips Medizin Systeme Boeblingen GmbH
Hewlett-Packard Strasse 2
71034 Boeblingen, Germany

[CE Mark]
# Table of Contents

## 1 Introduction
- Overview
- What’s New in This Release
- Understanding 12-Lead Transfer Station
- Understanding 12-Lead Transmission
- Where This Guide Fits
- Backing Up the Data

## 2 Installing 12-Lead Transfer Station
- Overview
- Before You Begin
- System Requirements
- Configuring Microsoft Fax Console
- Installing 12-Lead Transfer Station
- Activating the 12-Lead Transfer Station Software
- Registering 12-Lead Transfer Station
- Uninstalling 12-Lead Transfer Station
- Configuring 12-Lead Transfer Station
- Configuring Transfer Station Service Manager

## 3 Using Auto Send Lists
- Overview
- Understanding Auto Send Lists
- Sending a 12-Lead Report Automatically
- Sending a 12-Lead Report Manually

## 4 Configuring 12-Lead Transfer Station
- Overview
- Configuring General Settings
- Configuring Auto Send Lists
- Using a Default Auto Send List
- Creating an Auto Send List
- Setting Up Application Destinations
- Adding Network Connections
- Setting Up Fax Destinations
- Setting Up Printer Destinations
- Setting Up Email Address Destinations
- Managing Auto Send Lists
Introduction

These instructions provide information to help you set up and use 12-Lead Transfer Station. 12-Lead Transfer Station is a software application that is part of the 12-Lead Transmission option for the HeartStart MRx Monitor/Defibrillator.

**NOTE**

12-Lead Transfer Station is a web service. The application requires a static IP address that is connected to the Internet. The connection must be on at all time. In most cases, 12-Lead Transfer Station will not work with a standard desktop Internet connection. Philips Healthcare recommends that a professional network technician installs and configures 12-Lead Transfer Station.

To understand the whole 12-Lead Transmission option, read *12-Lead Transmission Implementation Guide*, which is included with the HeartStart MRx Monitor/Defibrillator or your upgrade package. *12-Lead Transmission Implementation Guide* provides information about implementing the complete solution.

Overview

This section has the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What’s New in This Release</td>
<td>1</td>
</tr>
<tr>
<td>Understanding 12-Lead Transfer Station</td>
<td>2</td>
</tr>
<tr>
<td>Understanding 12-Lead Transmission</td>
<td>3</td>
</tr>
<tr>
<td>Where This Guide Fits</td>
<td>4</td>
</tr>
<tr>
<td>Backing Up the Data</td>
<td>4</td>
</tr>
</tbody>
</table>

What’s New in This Release

The following features are new in 12-Lead Transfer Station:

- The HeartStart 12-Lead Transfer Station installation process uses new license and software activation methods. After you install 12-Lead Transfer Station, you can activate the product by the Internet or email within 60 days after you install the software. Activation is a Philips Healthcare antipiracy technology designed to verify that software products are licensed legitimately.

- If your HeartStart MRx Monitor/Defibrillator is version 9.x or higher and was purchased with the Bluetooth option, you can transmit 12-lead data to HeartStart 12-Lead Transfer Station using either Bluetooth® wireless file transfer or a cell phone.
Understanding 12-Lead Transfer Station

12-Lead Transfer Station runs on Windows Server 2003 or Windows XP Professional with an Internet Information Service (IIS) Web server. It receives 12-lead reports from Philips HeartStart MRx Monitor/Defibrillator. 12-Lead Transfer Station processes, stores, and displays the 12-lead reports. You can also send 12-lead reports to other applications, fax machines, printers, and email addresses.

HeartStart MRx uses Bluetooth wireless file transfer or a cell phone to send a stream of data that contains the 12-lead report and destination information to 12-Lead Transfer Station.

Intended use of HeartStart 12-Lead Transfer Station

The HeartStart 12-Lead Transfer Station application provides a diagnostic 12-lead ECG interface between Philips defibrillators and ECG Management Systems that can process XML formatted ECGs such as the TraceMasterVue ECG Management System.

The HeartStart 12-Lead Transfer Station application also allows viewing, printing, archiving, and further distribution of digitized ECG records.

12-Lead Transfer Station Services

12-Lead Transfer Station provides three services:

1. Automatically receive 12-lead reports from HeartStart MRx Monitor/Defibrillator

HeartStart MRx Monitor/Defibrillator is limited to choosing only one destination at a time. HeartStart MRx sends a 12-lead report to 12-Lead Transfer Station. 12-Lead Transfer Station sends the 12-lead report, according to instructions received from HeartStart MRx.

2. Automatically send 12-lead reports to multiple destinations

If a 12-lead report routinely goes to multiple destinations, such as a cath lab and on-call cardiologist, a 12-Lead Transfer Station user can set up the additional destinations. 12-Lead Transfer Station refers to this group of destinations as an Auto Send List.

When 12-Lead Transfer Station receives the 12-lead report, it automatically sends the 12-lead report to all destinations on the Auto Send List and to the destination specified by HeartStart MRx. Automatic transfer is the standard operation for 12-Lead Transfer Station. 12-Lead Transfer Station can send the 12-lead report to the following destinations:

- TraceMasterVue System
- 12-Lead Transfer Station application
- Datamed Format Translators (DatamedFT) software
- Fax machine
- Printer
- Email address

3. Manually view and send 12-lead reports

A 12-Lead Transfer Station user can view the system log to identify a newly received 12-lead report. The user can then choose to view the 12-lead report and send it to an Auto Send List or a configured destination. The user can also fax, print, and email a 12-lead report to an alternate destination, which is not configured for 12-Lead Transfer Station.

A user might want to do this if an automatic transfer was incomplete or there is a special request for a 12-lead report.
Understanding 12-Lead Transmission

Some HeartStart MRx documentation and 12-Lead Transmission Implementation Guide refer to 12-Lead Transfer Station as a hub. The term hub, as used in the documentation, refers to 12-Lead Transfer Station as the central point of communication.

The following steps describe 12-lead report transmission:

1. The HeartStart MRx operator uses wireless technology, such as Bluetooth, or a serial (RS232) cable to connect HeartStart MRx to a cell phone.
2. The HeartStart MRx operator uses HeartStart MRx to select a destination for the 12-lead report.
3. The HeartStart MRx operator presses Send on the HeartStart MRx to transmit the 12-lead report.
4. HeartStart MRx encrypts the 12-lead report.
5. Depending on the wireless technology, the following occurs:
   • The cell phone sends the 12-lead report through the Internet to 12-Lead Transfer Station.
   • HeartStart MRx transmits the 12-lead report directly to 12-Lead Transfer Station using a Bluetooth wireless transmission.
6. 12-Lead Transfer Station receives the 12-lead report.
7. 12-Lead Transfer Station decrypts the data and saves the 12-lead report to the database.
8. 12-Lead Transfer Station sends the 12-lead report, according to the instructions from HeartStart MRx.
9. If the 12-Lead Transfer Station user configured an Auto Send List, 12-Lead Transfer Station sends the 12-lead report to the destinations on the Auto Send List.
10. 12-Lead Transfer Station logs each action and the status of the action.
11. 12-Lead Transfer Station saves the 12-lead report to an archive.

An Example Use of 12-Lead Transfer Station

This section illustrates an example use of 12-Lead Transfer Station. A diagram follows the description.

A company has multiple HeartStart MRx defibrillators. If the company uses HeartStart MRx Monitor/Defibrillator version 9.x or later units (1), you can also transmit 12-lead reports directly to 12-Lead Transfer Station using Bluetooth wireless transmission.

Each HeartStart MRx can use a cell phone (2) to send a 12-lead report across the Internet (5) to a central 12-Lead Transfer Station (6). 12-Lead Transfer Station can also receive data from another 12-Lead Transfer Station (4).

12-Lead Transfer Station acts as a central point of communication to send the 12-lead reports to the following possible destinations:

- Email address (7)
- Fax machine (8)
- Printer (9)
- TraceMasterVue System (10)
- DatamedFT software (11)
- 12-Lead Transfer Station application (12)

The DatamedFT software supports ECG hosts, such as GE MUSE.

When a 12-Lead Transfer Station is a destination (12), it (12) can further distribute 12-lead reports automatically or manually to additional destinations.
Where This Guide Fits

The 12-lead transmission option provides tools to send 12-lead reports from HeartStart MRx to destinations.

This guide covers the process from the point where 12-Lead Transfer Station receives the 12-lead report. Many chapters in *12-Lead Transmission Implementation Guide* use information from this guide.

**Backing Up the Data**

The 12-Lead Transfer Station database is low-maintenance compared to many other databases. Nonetheless, attention to routine maintenance tasks will help to ensure database integrity. It is the database administrator’s responsibility to set up appropriate database management tools and to check that they execute successfully.

**CAUTION**

12-Lead Transfer Station does not back up your database. Maintaining proper backups is the database administrator’s responsibility.

Back up the 12-Lead Transfer Station database on a regular basis (preferably every day) to tape or some other medium. Disaster recovery experts recommend that you store the backup tapes somewhere safe, so that disasters such as fire or theft cannot harm them. Without a recent backup, you have no chance of recovery after a catastrophe (disk failure, fire, mistakenly dropping a critical table, etc.).
Installing 12-Lead Transfer Station

This section describes how to install and register 12-Lead Transfer Station. Philips Healthcare recommends that a professional network technician installs and configures 12-Lead Transfer Station. 12-Lead Transfer Station is a web service. The application requires a static IP address that is connected to the Internet. The connection must be on at all time.

Overview

This section has the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before You Begin</td>
<td>5</td>
</tr>
<tr>
<td>System Requirements</td>
<td>6</td>
</tr>
<tr>
<td>Configuring Microsoft Fax Console</td>
<td>6</td>
</tr>
<tr>
<td>Installing 12-Lead Transfer Station</td>
<td>7</td>
</tr>
<tr>
<td>Activating the 12-Lead Transfer Station Software</td>
<td>7</td>
</tr>
<tr>
<td>Registering 12-Lead Transfer Station</td>
<td>9</td>
</tr>
<tr>
<td>Uninstalling 12-Lead Transfer Station</td>
<td>9</td>
</tr>
<tr>
<td>Configuring 12-Lead Transfer Station</td>
<td>9</td>
</tr>
<tr>
<td>Configuring Transfer Station Service Manager</td>
<td>10</td>
</tr>
</tbody>
</table>

Before You Begin

Before you install 12-Lead Transfer Station, confirm that the following components are set up.

- Confirm that a static IP address is assigned to the 12-Lead Transfer Station and connected to the Internet.
- Confirm that the Internet connection is on all the time.
- Confirm that the application machine is set up according to the instructions in Setting Up the 12-Lead Transfer Station Web Service on page 47.
• Confirm that IIS is installed and running. Click Start > Control Panel > Administrative Tools > Services. For more information, see Setting up Internet Information Services (IIS) on page 49.
• Confirm that the Simple Mail Transfer Protocol (SMTP) service is set up according to the instructions. For more information, see Setting up the Simple Mail Transfer Protocol on page 50.

System Requirements

Confirm that your hardware and software support the following minimum system requirements for 12-Lead Transfer Station:
• Windows Server 2003 Standard Edition SP1 or later or Windows XP Professional SP2
• Computer/Processor: 1 GHZ or higher
• Display Resolution: 1024x768
• Memory: 1 GB or higher
• Hard Disk: 2 GB of available disk space during software installation
• Drive: CD-ROM drive
• Modem or network card for Internet, dial-up, dial-in, or fax connections
• Adobe Reader 5.0 or later to view the user guide and 12-lead reports
• Printer
• MAPI compliant email client

Philips Healthcare recommends that you store backup information at a separate location on an installed tape or other backup device. You should have a plan for recovering information in the case of a software or hardware failure.

Philips Healthcare also recommends that you have a telephone line and two modems if you use dial-up connections to TraceMasterVue, other 12-Lead Transfer Stations, or Fax forwarding. Dedicate one modem for fax use and the second modem for dial-up connections.

Configuring Microsoft Fax Console

Fax users should configure the Microsoft Fax Console for landscape printing.

Configure Microsoft Fax Console for the same account that runs the 12-Lead Transfer Station service.
• If you run 12-Lead Transfer Station as a service, this “account” must configure the Fax Console.
• If you run 12-Lead Transfer Station as a console application, the user who is logged on must configure the fax printer.

For more information, see Running Transfer Station Service Manager as a Service on page 51.

To configure Microsoft Fax Console

At the 12-Lead Transfer Station computer, display Fax Console. You might need the operating system installation CD.
1 From the Windows Start menu, click Control Panel, and then Printers and Faxes.
2 Double-click Fax.
3 On the Tools menu, click Fax Printer Configuration.
4 Click the General tab.
5 Click Printing Preferences and select Landscape Orientation.
6 Click OK to close the Fax Printing Preference window.
7 Click OK to close the Fax Properties window.
8 On the File menu, click Exit.

If the fax printer clips portions of the 12-lead report, consult your fax machine user’s manual for the subject “Reducing Faxes to Fit,” “Image Resizing,” or “Scaling.” This item is most often located in the menu under Fax options, Incoming faxes.

Installing 12-Lead Transfer Station

12-Lead Transfer Station saves an Auto Send List from a previous version as the default Auto Send List in this version.

Typically, you install the 12-Lead Transfer Station software from the Internet.

To install 12-Lead Transfer Station
1 Start Windows.
2 Start your Internet browser.
3 Type the URL provided in your product certificate and activation letter.
4 Browse to the 12-Lead Transfer Station installation file.
5 Double-click Setup.exe.
6 Follow the on-screen instructions.

Activating the 12-Lead Transfer Station Software

After you install 12-Lead Transfer Station, activate the product. Activation is a Philips Healthcare antipiracy technology designed to verify that software products are licensed legitimately.

You can use the Internet or email to activate 12-Lead Transfer Station within 60 days after you install the application. Until you complete the activation, you will see the Philips HeartStart Activation Wizard window when the application starts.

NOTE Save the serial number in a safe place that you can access in case you need to re-install the software.

If you have problems activating the software, place a telephone call to one of the following phone numbers.
Tell the operator you want to activate 12-Lead Transfer Station.
• In the United States, call 1 (800) 263-3342.
• Outside the United States, call 011 1 (206) 664-7745.

This topic includes the following methods:
• Activate Over the Internet on page 7
• Activate by Email on page 8
• Activate Later on page 9

Activate Over the Internet

You can activate the software by the Internet when you first install the application or within 60 days of installation.

The activation wizard sends encrypted information to the Philips server to validate that the serial number you enter has not already been used for the allowed number of installations and to activate your software. If you are not connected to the Internet, the wizard alerts you that there is no connection.
To activate the 12-Lead Transfer Station software by the Internet

1 Start **12-Lead Transfer Station**.  
   12-Lead Transfer Station opens Philips HeartStart Activation Wizard.
2 Type the serial number that you received.
3 Click **I want to activate the software by Internet**.
4 Click **Activate**.
   The wizard starts the application.

**Activate by Email**

You can request to activate the software by email after you first install the application or within 60 days of installation. The email activation involves exchanging emails with Philips Customer Support. The activation wizard attaches an encrypted file when it sends the activation request. Customer Support sends the activation code.

An email application must be installed on this computer or you must have access to an installed email application. You can continue to use the software for up to 60 days before you complete the activation.

If an email application is not installed on this computer, you can contact your sales representative or local sales office. Customer Support in English only is available by email or and by telephone. You can send an email to **12LTS.Support@philips.com**. Or, you can place a telephone call to 1-800-263-3342 (in the United States) or 206-664-7745 (outside the United States) between 9:00 AM and 5:00 PM, Pacific Time. You can also visit our Web site at **www.philips.com** for your local customer support telephone number.

**TIP**  
The Activation Wizard online Help includes the steps on how to activate the software by email. Print the Help for future use.

To activate the 12-Lead Transfer Station software by email

1 Start **12-Lead Transfer Station**. **12-Lead Transfer Station** open Philips HeartStart Activation Wizard.
2 Type the serial number that you received.
3 Click **I want to activate the software by email**.
4 Click **Next**.
5 Click **Request Activation Code** to open your email application with a pre-addressed email activation request.
6 Click **Send**.
   Customer Support will send you an email with the activation code.

When you receive an email from Customer Support, complete the following:

1 Start the application.
   The application opens the Philips HeartStart Activation Wizard.
2 Verify or type the serial number that you received.
3 Click **I want to activate the software by email**.
4 Click **Next** to access the Activate By Email page.
5 Type the activation code in the **Enter your activation code here** field.
6 Click **Activate**.
   The wizard validates your entry and displays a congratulations message.
7 Click **OK**.
   The wizard starts the application.
Customer Support

If your activation fails, please contact customer support using the following methods:

Email product support is available in English only at:
12LTS.Support@philips.com

For telephone assistance outside the United States, please call your sales representative or local sales office.
For telephone support in English only, you can call the following numbers between 9:00 AM and 5:00 PM, Pacific Time:

• 1-800-263-3342, in the United States
• 206-664-7745, outside the United States

Activate Later

If you do not want to activate your copy of the application when you start it, you can activate the software within 60 days when you start the application. At the end of the 60 days, you cannot download the application on the same computer.

During the 60 days, you can use the application and save your work.

Until you activate the software, you will see the Philips HeartStart Activation Wizard window each time that you start the application.

To use the application without activating the software

1. Start the application.
2. When Philips HeartStart Activation Wizard opens, click Skip.
   The wizard starts the application.

Registering 12-Lead Transfer Station

Registering your copy of 12-Lead Transfer Station helps Philips Healthcare to provide you with information and software updates.

You can register by the Internet at the following URL:

Uninstalling 12-Lead Transfer Station

If you need to remove 12-Lead Transfer Station, use Add/Remove Programs in Windows Control Panel.

The removal process contacts the Philips activation server and releases your serial number for installation on another computer. The removal process will not remove the 12-Lead Transfer Station database.

Configuring 12-Lead Transfer Station

The first time you install and start the 12-Lead Transfer Station application, the Configuration – General window appears. You can complete the general configuration of the application machine now or at a later time. For more information, see Configuring General Settings on page 14.

If you install an upgrade version of 12-Lead Transfer Station, the installation process migrates the previous configuration for the new release. For more information, see Setting Up the 12-Lead Transfer Station Web Service on page 47.
Configuring Transfer Station Service Manager

The default installation delivers 12-lead reports to 12-Lead Transfer Station only when a user is logged on and running 12-Lead Transfer Station. You can set up to receive 12-lead reports when 12-Lead Transfer Station machine is running but you are not logged on.

To receive 12-lead reports when you start the 12-Lead Transfer Station machine

1. On the Configuration menu, click Transfer Station Service Manager. The Configuration – Transfer Station Service Manager window lists the user name for the 12-Lead Transfer Station machine.
2. In Password, type the password for the user name. This is a required field.
3. In Confirm password, type the password for the user name.
4. In Startup type, select Automatic.
5. Click OK.
Using Auto Send Lists

The primary function of 12-Lead Transfer Station is to send 12-lead transmissions (12-lead reports) from HeartStart MRx Monitor/Defibrillator to one or more external destinations.

In 12-Lead Transfer Station, you can configure an Auto Send List to send 12-lead reports to multiple destinations at one time. Each destination name on HeartStart MRx can be a single destination on 12-Lead Transfer Station or the name of an Auto Send List. If the name of the HeartStart MRx destination is the name of the Auto Send List, 12-Lead Transfer Station sends the 12-lead report to each destination in the Auto Send List.

This section describes Auto Send Lists and how you can use an Auto Send List to send 12-lead reports from a HeartStart MRx to one or more destinations.

Overview

This section has the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding Auto Send Lists</td>
<td>11</td>
</tr>
<tr>
<td>Sending a 12-Lead Report Automatically</td>
<td>11</td>
</tr>
<tr>
<td>Sending a 12-Lead Report Manually</td>
<td>12</td>
</tr>
</tbody>
</table>

Understanding Auto Send Lists

In 12-Lead Transfer Station, an Auto Send List has a multi-dimensional use. You can configure an Auto Send List to send 12-lead reports to as many as 10 destinations. You can also configure as many as 10 Auto Send Lists on one 12-Lead Transfer Station. For example: One Auto Send List can consist of only one destination. And, the same destination can also appear on nine other Auto Send Lists.

You can configure a destination individually or while you configure an Auto Send List. During the Auto Send List configuration process, you can select one list to be the default Auto Send List. 12-Lead Transfer Station sends the 12-lead report to the default Auto Send List when the site name for the HeartStart MRx hub does not match the name of a configured Auto Send List.

Sending a 12-Lead Report Automatically

You can use an Auto Send List to send a 12-lead report to as many as 10 destinations automatically.

An Auto Send List can send a 12-lead report to the following types of destinations:

- TraceMasterVue application
• 12-Lead Transfer Station application
• DatamedFT software
• Fax machine
• Printer
• Email address

**NOTE** In 12-Lead Transfer Station, you can receive 12-lead reports from an earlier version of 12-Lead Transfer Station or the current version. However, you can only send encrypted 12-lead reports to the current version of 12-Lead Transfer Station.

You can configure an Auto Send List to be the default list.

• If the HeartStart MRx hub name matches the name of a configured Auto Send List, 12-Lead Transfer Station sends the 12-lead report to each destination in that Auto Send List.
• If the HeartStart MRx hub name does not match the name of a configured Auto Send List, 12-Lead Transfer Station sends the 12-lead report to each destination in the configured default Auto Send List.
• If the default Auto Send List names another 12-Lead Transfer Station as a destination, the originating default Auto Send List sends a 12-lead report to the 12-Lead Transfer Station destination. The destination in turn sends the 12-lead report to each destination the default Auto Send List for that 12-Lead Transfer Station.

If you do not configure a default Auto Send List and the HeartStart MRx hub does not match the configured Auto Send List, 12-Lead Transfer Station adds the 12-lead report to the database. You can then send the 12-lead report manually.

**Sending a 12-Lead Report Manually**

You can also send a selected 12-lead report manually to the following types of destinations:

• Auto Send List
• TraceMasterVue application
• 12-Lead Transfer Station application
• DatamedFT software
• Fax machine
• Printer
• Email address

Use the **Forward** menu option or toolbar button to send a selected 12-lead report to one of the configured Auto Send Lists or destinations. For more information, see **Forwarding 12-Lead Reports** on page 29.

Use the File menu to send a selected 12-lead report to the fax machine, printer, or email address that is not configured as a destination 12-Lead Transfer Station. You can also use the **Print** toolbar button to print a selected 12-lead report to the default printer. For more information, see the appropriate topic:

• **Forwarding 12-Lead Reports** on page 29
• **Faxing 12-Lead Reports** on page 29
• **Printing 12-Lead Reports** on page 30
• **Emailing 12-Lead Reports** on page 30
12-Lead Transfer Station provides three services:

• Automatically receive 12-lead reports from HeartStart MRx Monitor/Defibrillators
• Automatically send 12-lead reports to as many as 10 destinations through Auto Send Lists
• Manually view and send 12-lead reports to a single destination or to multiple destinations through an Auto Send List

This section describes how to configure 12-Lead Transfer Station to send 12-lead reports to multiple destinations at one time. For information on how to set up the application machine, see Setting Up the 12-Lead Transfer Station Web Service on page 47.

Working with 12-Lead Reports on page 25 describes how to manually send 12-lead reports to destinations.

Managing 12-Lead Reports on page 33 describes how you can manage the destinations that you configure for 12-Lead Transfer Station through the Configuration menu.

Overview

This section has the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring General Settings</td>
<td>14</td>
</tr>
<tr>
<td>Configuring Auto Send Lists</td>
<td>14</td>
</tr>
<tr>
<td>Using a Default Auto Send List</td>
<td>15</td>
</tr>
<tr>
<td>Creating an Auto Send List</td>
<td>15</td>
</tr>
<tr>
<td>Setting Up Application Destinations</td>
<td>16</td>
</tr>
<tr>
<td>Adding Network Connections</td>
<td>17</td>
</tr>
<tr>
<td>Setting Up Fax Destinations</td>
<td>18</td>
</tr>
<tr>
<td>Setting Up Printer Destinations</td>
<td>20</td>
</tr>
<tr>
<td>Setting Up Email Address Destinations</td>
<td>21</td>
</tr>
<tr>
<td>Managing Auto Send Lists</td>
<td>22</td>
</tr>
</tbody>
</table>
Configuring General Settings

Before you can receive and send 12-lead reports, you must specify how to store, fax, print, and email 12-lead reports. The installation process automatically installs the database server for you.

NOTE
The first time you install and start the 12-Lead Transfer Station application, the Configuration – General window appears.

By default, 12-Lead Transfer Station formats 12-lead reports with grids and in the time sequential format, and saves 12-lead reports in the database for 1000 days. You can change these settings. You can also specify how to email 12-lead reports.

To configure 12-Lead Transfer Station

1. On the Configuration menu, click General.
2. In Database server name, select the name of the database. You can select the name of a database on the Intranet.
   If you select a database that is not on the 12-Lead Transfer Station machine, set up the same printers for your machine login and for the 12-Lead Transfer Station machine.
3. In the 12-lead report area, select Print without grid to send the 12-lead reports to a fax machine, printer, or email address without grid lines. Use Print without grid when you use pre-printed grid paper.
   Clear the check box to fax, print, or email 12-lead reports with grid lines.
4. In the 12-lead report area, select Simultaneous to fax or print the 12-lead reports in the simultaneous format.
   Clear the check box to fax or print the 12-lead reports in the time sequential format.
5. In Report history, enter the number of days you want to save 12-lead reports in the database. The default number of days is 1000.
   You can type a number or click the up and down arrows to change a number.
   For information on how to delete 12-lead reports, see Deleting 12-Lead Reports on page 33.
6. In SMTP server name, type the IP address or name of the email server. 12-Lead Transfer Station uses this setting for emails that are sent through an Auto Send List.
   The SMTP server can be installed on the 12-Lead Transfer Station or another machine on the Intranet.
7. In Reply email address, type the return email address. 12-Lead Transfer Station uses this setting for emails that are sent through an Auto Send List.
8. Select Password for attachment to manually send an email attachment that is password protected.
   12-Lead Transfer Station uses this setting when you manually send emails from the File menu.
9. Click OK.

Configuring Auto Send Lists

HeartStart MRx can send a 12-lead report to one destination a time.

In 12-Lead Transfer Station, an Auto Send List has a multi-dimensional use. You can configure an Auto Send List to send a 12-lead report to as many as 10 destinations.

You can also configure as many as 10 Auto Send Lists on one 12-Lead Transfer Station. The name of the Auto Send List can be the user-assigned site name of the HeartStart MRx hub. You can provide a unique name and description for additional Auto Send Lists.

An Auto Send List can send a 12-lead report automatically to the following types of destinations:

- TraceMasterVue applications
- 12-Lead Transfer Station applications
Using a Default Auto Send List

You can also configure an Auto Send List to be the default list. A default Auto Send List automatically sends 12-lead reports to the destinations specified in the list.

- If the HeartStart MRx hub name matches the name of a configured Auto Send List, 12-Lead Transfer Station sends the 12-lead report to each destination in that Auto Send List.
- If the HeartStart MRx hub name does not match the name of a configured Auto Send List, 12-Lead Transfer Station sends the 12-lead report to each destination in the configured default Auto Send List.
- If the default Auto Send List names another 12-Lead Transfer Station as a destination, the originating default Auto Send List sends a 12-lead report to the 12-Lead Transfer Station destination. The destination then sends the 12-lead report to each destination in the matching Auto Send List name or default Auto Send List.

You can use email as a notification service. Add an email address in the default Auto Send List. 12-Lead Transfer Station sends an email to the email address each time the application receives a 12-lead report.

NOTE If you do not configure a default Auto Send List and the HeartStart MRx hub name does not match configured Auto Send Lists, 12-Lead Transfer Station adds the 12-lead report to the database. You can then send the 12-lead report manually.

Creating an Auto Send List

You can use the Configuration – Auto Send Lists window to complete the following tasks:

- Name an Auto Send List
- Configure destinations such as applications, fax machines, and email addresses
- Add destinations to the Auto Send List
- Remove destinations from the Auto Send List

TIP If you know that you will always send 12-lead reports to a specific destination, use the Configuration – Auto Send Lists window to configure the destination and select the destination for the Auto Send List. You can send the 12-lead report to as many as 10 Auto Send Lists on one 12-Lead Transfer Station.

If you occasionally send 12-lead reports to a specific destination, use the Configuration – Destinations windows to configure the destination. For more information, see Managing 12-Lead Report Destinations on page 34. The destination appears in the Forward lists. The Forward option is available from the File menu and toolbar.

To create an Auto Send List

1. On the Configuration menu, click Auto Send Lists.
2. In Name, select a name or type a name. The HeartStart MRx can use this name when specifying a destination.
3 In Description, type a brief description of the destinations or use of the Auto Send List.

4 Select Default Auto Send List to use the Auto Send List as the default list.
   If the HeartStart MRx hub name does not match the name of a configured Auto Send List, 12-Lead Transfer Station sends the 12-lead report to each destination in the configured default Auto Send List. If you do not configure a default Auto Send List and the HeartStart MRx hub name does not match the configured Auto Send Lists, 12-Lead Transfer Station adds the 12-lead report to the database. You can then send the 12-lead report manually.

5 In Application, select the name for an application or select Add to configure an application destination for 12-Lead Transfer Station.
   For more information on how to configure applications in 12-Lead Transfer Station, see Sending 12-Lead Reports to Applications on page 16.

6 In Fax, select the name for the fax machine or select Add to configure a fax destination for 12-Lead Transfer Station.
   For information on how to set up fax destinations in 12-Lead Transfer Station, see Sending 12-Lead Reports to Fax Machines on page 19.

7 In Printer, select the name for the printer.
   For information on how to set up printer destinations in 12-Lead Transfer Station, see Sending 12-Lead Reports to Printers on page 20.

8 In Email address, select the name of the email address or select Add to configure an email address destination for 12-Lead Transfer Station. For information on how to set up email destinations in 12-Lead Transfer Station, see Sending 12-Lead Reports to Email Addresses on page 21.

9 Click Apply to save the destinations in the Auto Send List.
10 Repeat steps 5 through 9 to add as many as 10 destinations to the Auto Send List.
11 Click OK to save the Auto Send List.

Setting Up Application Destinations

In 12-Lead Transfer Station, you can send a 12-lead report to an application.

Use the procedures in this section to send 12-lead reports from HeartStart MRx to one or more of the following applications automatically through an Auto Send List or manually from the Forward option.

- TraceMasterVue
- 12-Lead Transfer Station
- DatamedFT

NOTE You can send 12-lead reports from HeartStart MRx to a TraceMaster or another 12-Lead Transfer Station through 12-Lead Transfer Station. You do not need to configure any other settings on the 12-Lead Transfer Station. Set the Site Type in the MRx configuration to TraceMaster or 12-Lead Transfer Station and enter the URL.

Sending 12-Lead Reports to Applications

Use the Configuration – Auto Send Lists window to send 12-lead reports to one or more applications. You use the Configuration – Application window to set up an application destination. An application destination requires a name, location, and type of data connection.

NOTE To complete the dial-up connection for an application, you might need to know the User Name and Password for the machine account you are using to connect. For more information, see Adding Network Connections on page 17.
Adding Network Connections

To set up an application destination
1. In the Configuration – Auto Send Lists window, select or type an Auto Send List name in the Name field.
2. In Application, select Add from the list. 12-Lead Transfer Station displays the Configuration – Application window.
3. In Name, type a name for the application destination. For example, you might name the destination “Rosenberg hospital” or “Evergreen cath lab.”
4. In Description, you can type a brief description that describes the use of the application.
5. In Select a type, select one of the following applications from the list:
   - TraceMasterVue
   - 12-Lead Transfer Station
   - DatamedFT
      
      The DatamedFT software supports ECG hosts, such as GE MUSE.
6. In Location, type the location for the application.
      The location can be where the application is installed, network address for the application, or Internet address for the application. Refer to the example to the right of “Location” for the correct format.
7. If you select DatamedFT, type the location of the DatamedFT Inbox.
      You can click Browse to navigate to the location of the DatamedFT Inbox. The default location is:
      c:\DatamedFT\EKGfromPhilipsMRxXML_to_MUSE.
      Continue with step 10.
8. In the Network connection area, select the type of connection: Dial-up connection or LAN connection.
9. If you select Dial-up connection, complete the following steps:
   a. Select a connection or select Add from the list.
   b. If you clicked Add, complete the on screen instructions to set up a dial-up connection. For more information, see Adding Network Connections on page 17.
   c. In the Select a dial-up connection list, select that connection.
10. Click OK to add the destination in the Summary area.
11. Click Apply to save the destination in the Auto Send List. The entry in the field clears.
12. Repeat steps 2 through 11 to add application destinations.
13. Repeat steps 2 through 12 to configure another Auto Send List and additional application destinations.
14. Click OK to save the Auto Send Lists.

Adding Network Connections

If you have dial-up connections configured for your system, 12-Lead Transfer Station displays them in the Select a dial-up connections list. If you need to add connections, you can add them from Windows or the Configuration – Application window. To complete the dial-up connections, you might need to know the User Name and Password for the machine account you are using to connect.

To add a connection from Windows
1. Display the Network Connections window.
   a. Click the Windows Start button.
   b. Click Control Panel.
   c. Double-click Network Connections.
2. Click Create a new connection. Windows displays the New Connection Wizard window.
3. Follow the on-screen instructions.
To add a connection from 12-Lead Transfer Station

1. In the Configuration – Application window, click **Select a dial up connection** and select **Add**.
2. 12-Lead Transfer Station displays the Microsoft New Connection Wizard window.
3. The New Connection Wizard selects **Dial-up to private network** for you.
4. Click **Next**. The New Connection Wizard displays the **Phone Number to Dial** page.
5. Type the phone number in the format required by the dialing rules you set up for your computer.
6. Click **Next**. The New Connection Wizard displays the **Finished** page.
7. Type a name for this connection. The connection name can be anything that is meaningful to you.
8. Click **Finish**. The Connection Wizard displays the **Internet Account Information** page with the RAS user account information for the service.
9. Complete the fields on the page. This information is for the machine account you are using to connect to TraceMasterVue or 12-Lead Transfer Station. If you need help, contact the system manager for that application.
10. Click **Next**. The New Connection Wizard displays a completion message.
11. Click **Finish**. 12-Lead Transfer Station adds this connection to the **Select a dial-up connection** list.

### Setting Up Fax Destinations

In 12-Lead Transfer Station, you can send a 12-lead report using the Fax feature in the following ways:

- Sending a Fax from HeartStart MRx
- Sending 12-Lead Reports to Fax Machines

Use the procedures in this section to send 12-lead reports from HeartStart MRx to one or more fax machines automatically through an Auto Send List or manually from the **Forward** option.

### Fax Option Requirements

To use the Fax feature in 12-Lead Transfer Station, complete the following tasks:

- Connect 12-Lead Transfer Station to a fax modem.
- Install Microsoft Fax Service on the 12-Lead Transfer Station machine.
- Configure the retry settings in the Microsoft Fax Console window.
- Complete the fax settings using the Configuration – Auto Send Lists window.

### Configuring the Microsoft Fax Console

To ensure that faxed 12-lead reports are received in a timely manner, change the fax retry defaults in Windows Fax Console. Follow the steps below to minimize the number of retries and the amount of time between retries so that the fax queue does not fill up.

#### To set up Fax Console for Windows Server 2003

1. Log in as the user who will run 12-Lead Transfer Station as either a console application or as a service.
2. From the Windows Start menu, click **Programs > Accessories > Communications > Fax > Fax Console**.
3. In the left pane, right-click on **Fax (Local)**.
4. In the Fax Console window, click **Properties**.
5. In the Fax (Local) Properties window, click **Outbox**.
6. In **Number of retries**, enter 2.
7. In **Retry after**, enter 0 or 1.
From the File menu in the Fax Service Manage window, click Exit.
9 From the Tools menu in the Fax Console window, click Fax Printer Configuration.
10 Click the General tab, and then Printing Preferences.
11 In the Fax Printing Preferences window, select Landscape, and then click OK.
12 Click OK to close the Fax Properties window.
13 From the File menu in the Fax Console window, click Exit.

To set up Fax Console for Windows XP
1 From the Windows Start menu, click Printers & Faxes.
2 In the right pane, right-click on the Fax printer and click Properties.
3 In the Fax Properties window, click Devices, and then Properties.
4 Click the Send tab.
5 In Number of retries, enter 2.
6 In Retry after, enter 0 or 1.
7 Click OK.
8 In the Fax Properties window, click the General tab, and then click Printing Preferences.
9 In the Fax Printing Preferences window, select Landscape, and then click OK.
10 In the Fax Properties window, click OK.
11 From the File menu in the Fax Console window, click Exit.

Sending a Fax from HeartStart MRx
You can send 12-lead reports directly from HeartStart MRx through 12-Lead Transfer Station. Select Fax as the Site Type in the HeartStart MRx configuration screens. You do not need to configure any settings on the 12-Lead Transfer Station. The HeartStart MRx routing file contains the dialing information.

It is important that the HeartStart MRx user knows the dialing rules for the 12-Lead Transfer Station. For example, does the 12-Lead Transfer Station need to dial a 9 for an outside line or a 1 in addition to the number? If it does, the number sent by the HeartStart MRx must include these digits.

Sending 12-Lead Reports to Fax Machines
Use the Configuration – Auto Send Lists window to send 12-lead reports to one or more fax machines. 12-Lead Transfer Station does not list fax numbers that you might have added to the address book for Microsoft Fax Console.

You use the Configuration – Fax window to add each phone number to the Fax list. A fax destination requires a name and a fax number.

To add a fax machine to the Fax list
1 In the Configuration – Auto Send Lists window, select or type an Auto Send List name in the Name field.
2 In Fax, select Add from the list. 12-Lead Transfer Station displays the Configuration – Fax window.
3 In Name, type a name for the fax destination. For example, you might name the destination “Rosenberg hospital fax” or “Evergreen cath lab fax.”
4 In Description, you can type a brief description that describes the use or location of the fax machine.
5 In Fax number, type the phone number for the fax machine. Refer to the example phone format to the right of “Fax number.”
6 Click OK. 12-Lead Transfer Station lists the destination in the Summary area.
Setting Up Printer Destinations

In 12-Lead Transfer Station, you can set up one or more of the printers to send 12-lead reports automatically through an Auto Send List. You can also set up a default printer for the 12-Lead Transfer Station machine.

All printers must be on the same network as 12-Lead Transfer Station. You must define each printer in Windows. If you use a database that is not on the 12-Lead Transfer Station machine, you must set up the same printers for your machine login and for the 12-Lead Transfer Station machine.

Use the procedures in this section to configure a printer for the following uses:

- Manually print a report from the 12-Lead Transfer Station.
- Automatically print a specific report sent from the HeartStart MRx to the printers listed in the Auto Send List.
- Automatically print all reports sent from the HeartStart MRx to the printers listed in the Auto Send List.

Adding a Printer in Windows

The first step is to add a printer in the Windows operating system.

To add a printer to the Windows operating system

1. From the Windows Start menu on 12-Lead Transfer Station, click Printers and Faxes.
2. In the Printers and Faxes window, select Add a printer in the left pane. Windows displays the Add Printer Wizard window.
3. Follow the on-screen instructions.
4. Repeat steps 1 through 3 to add printers.

After you add printers in Windows, add each printer in 12-Lead Transfer Station. For more information, see To add printers to the Auto Send List on page 21.

Sending 12-Lead Reports from HeartStart MRx

To send 12-lead reports to a printer directly from HeartStart MRx, you must define the printer in Windows.

Sending 12-Lead Reports to Printers

To automatically send 12-lead reports to a printer or multiple printers, complete the following tasks:

- Select the print style in the Configuration – General window.
- Select the printers to add to or remove from the Auto Send List in the Configuration – Auto Send Lists window.

To select the print style

1. On the Configuration menu, click General.
2. In the Configuration – General window, complete the fields in the 12-lead report area. For more information, see Configuring General Settings on page 14.
To add printers to the Auto Send List
1. On the Configuration menu, click **Auto Send Lists**.
2. In the Configuration – Auto Send Lists window, select or type an Auto Send List name in the **Name** field.
3. In **Printers**, select a printer name from the list. If the printer you want is not in the list, see *Adding a Printer in Windows* on page 20.
4. Click **Apply** to save the destination in the Auto Send List. The entry in the field clears.
5. Repeat step 3 and 4 to add printers to the Auto Send List. 12-Lead Transfer Station will automatically send all 12-lead reports to the printers you chose in the Summary area.
6. Click **OK** to save the Auto Send List.

**Setting Up Email Address Destinations**

In 12-Lead Transfer Station, you can send a 12-lead report using the Email feature. For more information, see *Sending 12-Lead Reports to Email Addresses*.

Use the procedures in this section to send 12-lead reports from HeartStart MRx to one or more email addresses automatically through an Auto Send List or manually from the **Forward** option.

**Email Requirements**

To use the Email feature in 12-Lead Transfer Station, complete the following tasks:

- Install the email application on the 12-Lead Transfer Station. For more information, see the instructions for your email application.
- Install the SMTP server for use with IIS, if you want to email 12-lead reports through an Auto Send List. For more information, see *Setting up Internet Information Services (IIS)* on page 49 and *Setting up the Simple Mail Transfer Protocol* on page 50.
- Configure the email settings in the Configuration – General window. For more information, see *Configuring General Settings* on page 14.
- Complete the email settings using the Configuration – Auto Send Lists window. For more information, see *Sending 12-Lead Reports to Email Addresses* on page 21.

**Sending 12-Lead Reports to Email Addresses**

Use the Configuration – Auto Send Lists window to send 12-lead reports to one or more email addresses. 12-Lead Transfer Station does not list email addresses that you might have added to the email address book.

You use the Configuration – Email window to add each email address to the **Email address** list. An email address destination requires a name and an email address.

You can also assign a password to the attached 12-lead report.

**NOTE** Make sure to tell the recipient the password you assign to an attachment in a separate communication or email.

To add an email address to the Email list
1. In the Configuration – Auto Send Lists window, select or type an Auto Send List name in the **Name** field.
2. In **Email address**, select **Add** from the list. 12-Lead Transfer Station displays the Configuration – Email window.
3. In **Name**, type a name that is associated for the email address. For example, you might name the destination “Rosenberg hospital email” or “Evergreen cath lab email.”
4 In **Description**, you can type a brief description that describes the use for the email address.

5 In **Email address**, type the email address. Refer to the example format to the right of “Email address.”

6 To email password protected 12-lead reports, select **Enable password** and type a password. 12-Lead Transfer Station assigns the password to each 12-lead report that the Auto Send List sends to this email address.

7 Click **OK**. 12-Lead Transfer Station lists the destination in the Summary area.

8 Click **Apply** to save the destination in the Auto Send List. The entry in the field clears.

9 Repeat steps 2 through 9 to add email addresses.

10 Click **OK** to save the Auto Send List.

## Managing Auto Send Lists

In 12-Lead Transfer Station, you can manage an Auto Send List through the Configuration – Auto Send Lists window in the following ways:

- Add and delete individual destinations in the Auto Send List
- Add, edit, and delete Auto Send Lists

### CAUTION

If you configured a destination through the Configure – Auto Send Lists window, 12-Lead Transfer Station deletes the destination associated with the Auto Send List from the database. However, if you assigned the same destination in other Auto Send Lists, 12-Lead Transfer Station removes only the Auto Send List name from the database. 12-Lead Transfer Station does not remove the destinations that are associated with the other Auto Send Lists.

### To add an Auto Send List

- Complete the same steps that you used to configure an Auto Send List. For more information, see **Creating an Auto Send List** on page 15.

### To edit an Auto Send List

You can add or edit a destination from the Auto Send List. To edit a destination, use the Configuration – Destination windows. For more information, see **Managing 12-Lead Report Destinations** on page 34.

### TIP

You can rename the default Auto Send List from the HeartStart MRx to a more meaningful name.

1 On the Configuration menu, click **Auto Send Lists**.

2 In **Name**, select the name of the Auto Send List. 12-Lead Transfer Station lists the destinations in the Summary area.

3 Change each setting that you want to edit.

   If you rename a default Auto Send List, 12-Lead Transfer Station creates a new Auto Send List with the same destinations. The list, however, is no longer marked as the default Auto Send List. To use this list as the default Auto Send List, you can either delete or edit the original default Auto Send List name.

4 To add a destination, complete the following steps:
   a In the Destination area, select the appropriate destination type.
   b If you select a destination name, 12-Lead Transfer Station displays the information in the Summary area.
   c If you select **Add**, 12-Lead Transfer Station displays the appropriate window. For more information, see the following topics:

      **Sending 12-Lead Reports to Applications** on page 16
5 To delete a destination, select the destination in the Summary area and click Delete.
6 Click OK.

To delete an Auto Send List

1 On the Configuration menu, click Auto Send List.
2 In Name, select the name of the Auto Send List. 12-Lead Transfer Station lists the destinations in the Summary area.
3 In the Name area, click Delete. 12-Lead Transfer Station asks you to confirm the deletion.
4 Click Yes to delete the Auto Send List or No to cancel the deletion.
5 Repeat steps 2 through 4 to delete additional Auto Send Lists.
6 Click OK.
Working with 12-Lead Reports

This section provides an overview of the 12-Lead Transfer Station window. It also explains how to import, view, forward, fax, print, and email 12-lead reports manually.

Configuring 12-Lead Transfer Station on page 13 covers how to configure the system to send 12-lead reports to destinations automatically.

Managing 12-Lead Reports on page 33 covers how to manage 12-lead report destinations.

Overview

This section has the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using 12-Lead Transfer Station Tools</td>
<td>25</td>
</tr>
<tr>
<td>Using the Report Tree</td>
<td>26</td>
</tr>
<tr>
<td>Viewing the System Log</td>
<td>27</td>
</tr>
<tr>
<td>Importing 12-Lead Reports</td>
<td>27</td>
</tr>
<tr>
<td>Saving a 12-Lead Report as an XML File</td>
<td>28</td>
</tr>
<tr>
<td>Forwarding 12-Lead Reports</td>
<td>29</td>
</tr>
<tr>
<td>Faxing 12-Lead Reports</td>
<td>29</td>
</tr>
<tr>
<td>Printing 12-Lead Reports</td>
<td>30</td>
</tr>
<tr>
<td>Emailing 12-Lead Reports</td>
<td>30</td>
</tr>
</tbody>
</table>

Using 12-Lead Transfer Station Tools

The 12-Lead Transfer Station application provides tools to select and view 12-lead reports that were received from an HeartStart MRx. From the 12-Lead Transfer Station window, you can send a 12-lead report manually to the following destinations:

- Auto Send List
- TraceMasterVue application
- DatamedFT software
12-Lead Transfer Station also provides tools to import 12-lead reports from a data card. After you import a 12-lead report, you can send the 12-lead report to a configured destination. For example, you can send a 12-lead manually when a 12-lead report failed to print, a fax was illegible, or you need to send a 12-lead report to someone as a special request.

The 12-Lead Transfer Station window consists of the report tree in the left pane and the work area in the right pane. The work area can display a 12-lead report or the system log. For the initial view, the system log is empty.

Using the Report Tree

Use the report tree to view a 12-lead report or to send a 12-lead report manually to a destination.

When 12-Lead Transfer Station imports a 12-lead report, the report tree displays details about the 12-lead report. The details depend upon the information sent by HeartStart MRx.

The default view of the report tree identifies each 12-lead report by the ECG ID supplied by HeartStart MRx. If HeartStart MRx sent a patient name, the report tree displays the name on the same line.

**TIP**

Place the mouse or cursor over the ECG ID to display incident information, including the incident ID, the time and date when the ECG was acquired, and the patient ID.

To expand a line, click the expand symbol to the left of the ECG ID. The report tree displays two branches for the 12-lead report: the date and time when the ECG was acquired and the Patient ID or the ECG ID.

To view a 12-lead report

1. In the report tree, double-click the ECG ID. 12-Lead Transfer Station displays the 12-lead report in the work area.

You can view the 12-lead report in one of two formats: time sequential or simultaneous. 12-Lead Transfer Station displays the 12-lead report in the format set up on the Configuration – General window. By default, 12-Lead Transfer Station displays the 12-lead report in the time sequential format. For more information, see Configuring General Settings on page 14.

**TIP**

A time sequential 12-lead ECG report marks each segment with a single vertical line. A simultaneous 12-lead ECG report marks each segment with double vertical lines.

To view a 12-lead report in a different format

1. In the report tree, double-click the ECG ID. 12-Lead Transfer Station displays the 12-lead report in the work area.
2. On the View menu, click 12-Lead ECG.
3. Click Time Sequential or Simultaneous.

To send a 12-lead report manually

1. In the report tree, double-click the ECG ID. 12-Lead Transfer Station displays the 12-lead report in the work area.
2. Select an action from the following list.
Filtering the Report Tree

By default, the report tree displays a list of all imported 12-lead reports. You can change the display to view 12-lead reports imported to 12-Lead Transfer Station during the last three, seven, or 30 days. 12-Lead Transfer Station uses the date you imported the 12-lead report, not the date of the ECG, to change the display.

To limit the view
1. On the View menu, click Filters. 12-Lead Transfer Station displays a list of options.
2. Click the filter you want to apply.

Setting the Report History

The Configuration – General window provides a setting to configure how long 12-Lead Transfer Station saves 12-lead reports in the database. The default is 1000 days. 12-Lead Transfer Station displays a prompt when the time expires. 12-Lead Transfer Station does not automatically delete the 12-lead reports from the database.

You cannot retrieve a deleted 12-lead report.

To change the default value
1. On the Configuration menu, click General. 12-Lead Transfer Station displays the Configuration – General window.
2. In Report history, use the up and down buttons to change the value or type a new value.

Viewing the System Log

You can view the system log to see the status of all 12-Lead Transfer Station activity.

To view the system log
◆ On the toolbar, click View System Log.

The system log has tools to change the way information displays. You can sort, group, and filter the list of entries. A filter shows only the entries that meet the criteria you select.

You change the way the system log displays information when you want to analyze data or search for specific information. For help using these tools, see Working with the System Log on page 39. For an explanation of the messages, see System Log Messages on page 44.

Importing 12-Lead Reports

If you receive 12-lead reports on a data card, you can use 12-Lead Transfer Station to import the 12-lead reports.
If you configured 12-Lead Transfer Station with a default Auto Send List, 12-Lead Transfer Station automatically sends the imported 12-lead reports to all the destinations in the default Auto Send List. If you do not want 12-Lead Transfer Station to send an imported 12-lead report to a destination, delete the destination from the Auto Send List Summary area. For more information, see Managing Auto Send Lists on page 22.

Importing 12-Lead Reports from a HeartStart MRx Data Card

When you insert a HeartStart MRx card into the card reader, 12-Lead Transfer Station automatically detects the card and begins to process the data.

12-Lead Transfer Station searches the card for a 12-lead folder. It displays a message informing you of the number of 12-lead reports in the folder and asks if you want to import the 12-lead reports. Click Yes to import all 12-lead reports in the folder. Click No to cancel the process.

You cannot select specific 12-lead reports. After the import is complete, you can delete any unwanted 12-lead reports from the report tree. For more information, see To delete a specific 12-lead report on page 34.

After 12-Lead Transfer Station imports or you reject to import the 12-lead reports, 12-Lead Transfer Station searches for another folder. When 12-Lead Transfer Station finds a folder, the application repeats the process for each folder.

Importing 12-Lead Reports from Additional Sources

Use the Import option to import a 12-lead report manually from other sources, such as additional data cards, memory sticks, or another location.

To import and display a 12-lead report
1 Insert the data card into the appropriate reader.
2 On the File menu or toolbar, click Import. 12-Lead Transfer Station displays the Windows standard Open window.
3 Navigate to the location of the 12-lead report.
4 Click the 12-lead report name.
5 Click Open. 12-Lead Transfer Station displays the 12-lead report in the work area.

Saving a 12-Lead Report as an XML File

You can save an imported 12-lead report as an XML file.

To save the 12-lead report as an XML file
1 Import the 12-lead report. For more information, see Importing 12-Lead Reports on page 27.
2 Display the 12-lead report. For more information, see Using the Report Tree on page 26.
   12-Lead Transfer Station displays the 12-lead report in the work area.
3 On the File menu, click Save As.
4 In Name, enter the 12-lead report name. You can select the 12-lead report file name from another location.
   The XML file type appears in the Save as type field.
5 Click OK.
Forwarding 12-Lead Reports

Use the Forward option to manually send a 12-lead report to an Auto Send List or a configured destination. The available destinations on the menu depend upon the destinations set up from the Configuration menu. For more information, see Configuring 12-Lead Transfer Station on page 13 and Managing 12-Lead Reports on page 33.

NOTE A TraceMaster ECG Management System cannot process a 12-lead report if the filter settings are between .05 and 40 Hz. The HeartStart MRx operator sets this filter. The TraceMasterVue and GE MUSE do not have this restriction.

To send a 12-lead report to an Auto Send List or a destination
1 In the report tree, double-click the ECG ID. 12-Lead Transfer Station displays the 12-lead report in the work area.
2 On the toolbar, click the down arrow to the right of Forward. 12-Lead Transfer Station displays another menu with the following options:
   - Auto Send Lists
   - TraceMasterVue
   - 12-Lead Transfer Station
   - DatamedFT
   - Fax
   - Printer
   - Email
   The available destinations on the menu depend upon the destinations you set up from the Configuration windows.
3 Select the type of destination. 12-Lead Transfer Station displays a list of destination names.
4 Click a destination name. 12-Lead Transfer Station completes the connection, sends the 12-lead report, and displays a confirmation message.

Faxing 12-Lead Reports

You can fax a 12-lead report automatically or manually.
12-Lead Transfer Station automatically faxes 12-lead reports to the fax numbers that you add to the Auto Send List.

You can also send a 12-lead report to a configured fax destination manually. These fax numbers are available from the Forward option on the File menu and toolbar. Use the Forward option when you want to forward a 12-lead report to one fax destination.

Use the Fax/Print option on the File menu to manually fax a 12-lead report to a fax destination that is not configured on 12-Lead Transfer Station. 12-Lead Transfer Station displays the Microsoft Send Fax Wizard.

NOTE Send Fax Wizard is part of Microsoft Fax Service. If you have not installed Microsoft Fax Console, use the Windows Help and Support feature. Type Fax in the Search field and follow Microsoft’s instructions.

To manually fax a 12-lead report to a configured destination
Use the steps listed in To send a 12-lead report to an Auto Send List or a destination on page 29.

To manually fax a 12-lead report to an alternate fax destination
1 In the report tree, double-click the ECG ID.
2 On the File menu, click Fax/Print. 12-Lead Transfer Station displays the Print window.
3 Select the fax printer name.
4 Click OK. 12-Lead Transfer Station displays the Send Fax Wizard window. Follow the on-screen instructions.

**Printing 12-Lead Reports**

You can print a 12-lead report automatically or manually.

12-Lead Transfer Station automatically prints 12-lead reports to the printers that you add to the Auto Send List.

You can manually print a 12-lead report using the **Forward**, **Print**, and **Fax/Print** options. You might print a 12-lead report manually when the following situations occur:

- A printer jammed while printing a 12-lead report
- You need an additional copy of a 12-lead report
- A printer is not configured for Auto Send Lists
- You imported a 12-lead report

Use the **Forward** option when you want to print a 12-lead report on a printer destination that is listed in an Auto Send List. The **Forward** option is on the File menu and toolbar.

Use the **Print** option when you want to print a 12-lead report to the default printer.

Use the **Fax/Print** option to manually print a 12-lead report to an alternate printer.

To manually print a 12-lead report to a printer configured for 12-Lead Transfer Station

Use the steps listed in **To send a 12-lead report to an Auto Send List or a destination** on page 29.

To manually print a 12-lead report to your default printer

1 In the report tree, double-click the ECG ID.
2 On the toolbar, click **Print**. 12-Lead Transfer Station sends the 12-lead report to your default printer.

To manually print a 12-lead report to an alternate printer

1 In the report tree, double-click the ECG ID.
2 On the File menu, click **Fax/Print**. 12-Lead Transfer Station displays the Print window.
3 Select the printer and printer options.
4 Click OK. 12-Lead Transfer Station sends the 12-lead report to the selected printer.

**Emailing 12-Lead Reports**

You can email a 12-lead report automatically or manually.

12-Lead Transfer Station automatically emails 12-lead reports to the email addresses that you add to the Auto Send List.

You can also send a 12-lead report to a configured email address manually. These email addresses are available from the **Forward** option on the File menu and toolbar. Use the **Forward** option when you want to forward a 12-lead report to one email address.

Use the **Email** option on the File menu to manually email a 12-lead report. 12-Lead Transfer Station starts your default email application. For example, 12-Lead Transfer Station might start Lotus Notes, Microsoft Outlook, or Outlook Express.

To manually email a 12-lead report to an email address configured for 12-Lead Transfer Station

Use the steps listed in **To send a 12-lead report to an Auto Send List or a destination** on page 29.
To manually email a 12-lead report to an alternate email address

Depending upon the configuration for manually sent emails, you can assign a password to the attachment.

**NOTE** Make sure to tell the recipient the password that you assign to an attachment in a separate communication or email.

1. In the report tree, double-click the ECG ID.
2. On the File menu, click **Email**. 12-Lead Transfer Station starts your default email application.
3. If you enabled passwords for the manual emails on the Configuration – General window, 12-Lead Transfer Station displays the Password for Attachment window.
   - Type a password and click **OK** to password protect the attachment. The password can be the same password that you assigned to an email address in the Configuration – Email window. For more information, see **Setting Up Email Address Destinations** on page 21. 
   -or-
   - Click **OK** to email the attachment without a password.

12-Lead Transfer Station starts your default email application and attaches the 12-lead report.

4. Address and send the email.
Managing 12-Lead Reports

In 12-Lead Transfer Station, you can manage the 12-lead reports saved in the database. You can also manage the destinations that you set up through the Configuration – Auto Send List and Configuration – Destination windows.

This section describes how to delete 12-lead reports and how to manage the following destinations:

- Applications
- Fax machines
- Printers
- Email addresses

Overview

This section has the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleting 12-Lead Reports</td>
<td>33</td>
</tr>
<tr>
<td>Managing 12-Lead Report Destinations</td>
<td>34</td>
</tr>
<tr>
<td>Managing Applications</td>
<td>34</td>
</tr>
<tr>
<td>Managing Fax Machines</td>
<td>35</td>
</tr>
<tr>
<td>Managing Printers</td>
<td>36</td>
</tr>
<tr>
<td>Managing Email Addresses</td>
<td>36</td>
</tr>
</tbody>
</table>

Deleting 12-Lead Reports

By default, 12-Lead Transfer Station keeps 12-lead report entries 1000 days. You can change this setting in the Configuration – General window. 12-Lead Transfer Station displays a prompt when the time expires. 12-Lead Transfer Station does not automatically delete the entries from the database.

You can delete 12-lead reports in the following ways:

- Delete all 12-lead reports from the database
- Delete all obsolete 12-lead reports from the report tree
- Delete a specific 12-lead report from the report tree
Use the **General** option on the Configuration menu to manage and delete all 12-lead reports.

Use the **Delete Obsolete 12-Lead** and **Delete Displayed 12-Lead** options on the File menu to delete 12-lead reports from the report tree.

**CAUTION** You cannot retrieve a deleted 12-lead report.

---

**To delete all 12-lead reports from the database**

1. On the Configuration menu, click **General**. The Configuration – General window appears.
2. In the 12-lead report area, click **Delete All**.
3. Click **Yes**.

**To delete the obsolete 12-lead reports**

1. On the File menu, click **Delete Obsolete 12-Lead**. 12-Lead Transfer Station displays a message telling you how many entries are obsolete and requests permission to delete them.
2. Click **Yes**.

**To delete a specific 12-lead report**

1. In the report tree, double-click on the ECG ID. 12-Lead Transfer Station displays the 12-lead report in the work area.
2. On the File menu, click **Delete Displayed 12-Lead**.
3. Click **Yes** to delete the 12-lead report or **No** to cancel the process.

---

**Managing 12-Lead Report Destinations**

You can add and edit destinations without attaching the destination to an Auto Send List. You can also remove the destination from the Auto Send List when you edit the destination.

Use the **Destinations** option on the Configuration menu to add, edit, and delete individual destinations.

Use the procedures in this section to add, edit, or delete destinations.

**To manage a destination**

1. On the Configuration menu, click **Destinations**.
2. On the Destinations menu, click the type of destination you want to manage. 12-Lead Transfer Station displays the appropriate window for the type of destination.

---

**Managing Applications**

Use the procedures in this section to add, edit, or delete application destinations in the Configuration – Destinations – Applications window.

**To add an application**

When you add an application destination, you can also add the application to an Auto Send List.

1. On the Configuration menu, click **Destinations**, and then click **Application**.
2. Complete the same steps as you used to set up an application destination on the Configuration – Application window. Begin with step 3 in **To set up an application destination** on page 17.
3. (Optional) In **Auto Send List name**, select the Auto Send List name in which you want to add the application destination. Leave the field blank if you want to send the 12-lead report manually from the **Forward** option and not through an Auto Send List.
Managing Fax Machines

Use the procedures in this section to add, edit, or delete fax machines in the Configuration – Destinations – Fax window.

To add a fax machine destination
When you add a fax machine destination, you can also add the fax machine to an Auto Send List.

1. On the Configuration menu, click Destinations, and then click Fax. The Configuration – Destinations – Fax window appears.
2. In Name, type a name for the fax destination. For example, you might name the destination “Rosenberg hospital fax” or “Evergreen cath lab fax.”
3. In Description, type a brief description that describes the use or location of the fax machine.
4. In Fax number, type the phone number for the fax machine. Refer to the example phone format to the right of “Fax number.”
5. (Optional) In Auto Send List name, select the Auto Send List name in which you want to add the fax number. Leave the field blank if you want to send the 12-lead report manually from the Forward option and not through an Auto Send List.
6. Click Apply to add the fax machine to the Summary area.
7. Repeat steps 2 through 6 to add another fax machine to the Summary area.
8. Click OK.
To edit a fax machine destination

You can change the name, Auto Send List name, fax number, and description for a fax machine. When you change the Name or Auto Send List name fields, 12-Lead Transfer Station adds a destination to the Summary area. When you change the Description or Fax number fields, 12-Lead Transfer Station updates the current destination.

1. In the Configuration – Destinations – Fax window, select a destination name from the Summary area.
2. In the Add a fax area, change each setting that you want to edit.
3. Click Apply. 12-Lead Transfer Station updates the destination in the Summary area.
4. Repeat steps 1 through 3 to edit another fax machine destination.
5. Click OK.

To delete a fax machine destination

When you delete a fax machine destination, you remove the destination from the 12-Lead Transfer Station database.

1. In the Configuration – Destinations – Fax window, select a destination name from the Summary area.
2. Click Delete.
3. Repeat steps 1 and 2 to delete another fax machine destination.
4. Click OK.

Managing Printers

You can add or remove a printer for use in 12-Lead Transfer Station from Windows.

You can also add or remove a printer from an Auto Send List.

For more information, see the following topics:
- Adding a Printer in Windows on page 20
- Sending 12-Lead Reports to Printers on page 20
- To edit an Auto Send List on page 22

Managing Email Addresses

Use the procedures in this section to add, edit, or delete email addresses in the Configuration – Destinations – Email window.

To add an email address destination

When you add an email address destination, you can also add the email address to an Auto Send List.

1. On the Configuration menu, click Destinations, and then click Email. The Configuration – Destinations – Email window appears.
2. In Name, type a name for the email address. The name must be the name that is associated with the email address. For example, you might name the destination “Rosenberg hospital” or “Evergreen cath lab.”
3. In Description, type a brief description that describes the use or location of the email address.
4. In Email address, type the email address.
5. (Optional) In Auto Send List name, select the Auto Send List name in which you want to add the email. Leave the field blank if you want to send the 12-lead report manually from the Forward option and not through an Auto Send List.
6. To email password protected 12-lead reports, select Password for attachment and type a password.
7 Click **Apply** to add the email address to the Summary area.
8 Repeat steps 2 through 7 to add another email address to the Summary area.
9 Click **OK**.

**To edit an email address destination**

You can change the name, description, email address, and Auto Send List name for an email address destination. You can also enable or disable a password. When you change the **Name** or **Auto Send List name** fields, 12-Lead Transfer Station adds a destination to the Summary area. When you change the **Description** and **Password for attachment**, and **Send to hand held device** fields, 12-Lead Transfer Station updates the current destination.

1 In the Configuration – Destinations – Email window, select a destination name from the Summary area.
2 In the Add an email address area, change each setting that you want to edit.
3 Click **Apply**. 12-Lead Transfer Station updates the destination to the Summary area.
4 Repeat steps 1 through 3 to edit another email address destination.
5 Click **OK**.

**To delete an email address destination**

When you delete an email address destination, you remove the destination from the 12-Lead Transfer Station database.

1 In the Configuration – Destinations – Email window, select a destination name from the Summary area.
2 Click **Delete**.
3 Repeat steps 1 and 2 to delete another email address destination.
4 Click **OK**.
Working with the System Log

This section provides an overview of how use the system log in 12-Lead Transfer Station. When working with the system log, you can change the way information displays in the list of entries. You can sort, group, and filter the list of entries. A filter shows only those entries that meet the criteria you select.

To display the system log
- On the toolbar, click View System Log.

Overview

This section discusses the following tools:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Columns</td>
<td>39</td>
</tr>
<tr>
<td>Sorting System Log Entries</td>
<td>40</td>
</tr>
<tr>
<td>Grouping System Log Entries</td>
<td>40</td>
</tr>
<tr>
<td>Filtering System Log Entries</td>
<td>40</td>
</tr>
<tr>
<td>Removing Filters</td>
<td>44</td>
</tr>
<tr>
<td>System Log Messages</td>
<td>44</td>
</tr>
</tbody>
</table>

Working with Columns

You can resize the width of a column and change the order in which the columns appear in the system log.

To change a column width
- Use the mouse to click and hold the column border edge, and then drag the border to the size you prefer.

To change the order in which columns appear
- Use the mouse to click and hold the column header, and then drag the column to the left or right to a new location.
7 Working with the System Log

Sorting System Log Entries

To change the sort order of a column, click in the column header. 12-Lead Transfer Station displays a triangular symbol (arrow) that changes direction to indicate the sort order.

Grouping System Log Entries

Group entries to sort the system log by multiple criteria. For example, you can select a primary sort by Date and Time and a secondary sort by Action. The system log gathers all cases created at a specific time with the same Action into one group. If you expand a group, the system log displays all the entries in the group.

Use the area above the system log to set up groups. To set up a group, you select a column header.

If a column header has a triangular symbol (arrow), you can click the arrow to sort the list of values in ascending (1 to 9, or a to z) or descending (9 to 1, or z to a) order.

To group system log entries
1. Click a column header in the system log and drag it to the grouping area with the notation Drag a column header here to group by that column.
   The column name moves to the grouping area.
2. Repeat step 1 as necessary.
   The system log creates the next group level.

Tip: Click the arrow in the column header to sort the order of the entries.

To expand a group

◆ Click the expand symbol to the left of the group you want to expand. An expanded group lists all the entries assigned to that group.

To collapse a group

◆ Click the collapse symbol to the left of the group you want to collapse. A collapsed group displays the group title.

To undo grouping for a single column

◆ Click a column header in the grouping area and drag it to the system log.

To undo grouping for all columns
1. Click a column header in the grouping area and drag it to the system log.
2. Repeat step 1 for each column.

Filtering System Log Entries

A filter limits the number of entries that appear in the system log. Each additional criteria condition that you specify for the system log creates a smaller subset of entries that appear in the system log. You can combine filtering with sorting and grouping.

Use the upper area of the system log to filter the list of entries in the system log. To set up a filter, you select a column header and specify a value to use as a criteria condition. To further refine the list, you can set up additional criteria conditions.

The system log evaluates the list of entries by comparing the each entry to the last criteria condition. The system log then compares the entries that meet the last criteria condition to the previous criteria condition. The system log displays the entries that meet the two criteria conditions. The system log repeats the process for each criteria condition and refreshes the list of entries.
To filter system log entries

If a column header has a triangular symbol (arrow), you can click the arrow to sort the list of values in
ascending (1 to 9, or a to z) or descending (9 to 1, or z to a) order.

1. Click **Click here to add filter criteria**. The system log displays a row for the criteria condition.
2. Click **Choose Field** and select a system log column name.
   For example, to limit the display to entries with one specific action, select **Action**.
3. Click **Equal** and select an operator that qualifies the value for the column. You can specify a specific
   value or a range of values. For a description of each operator that specifies a value, see **Comparison Operators** on page 41.
   For example, to limit the display to entries with one specific action, select **Equal**.
4. In the next field, click the down arrow and select a value for the column that you selected.
   The system log lists only the entries that meet the criteria condition.
   For example, to limit the display to entries with the action, ECG saved, select **ECG saved**. The system log lists only the 12-lead reports saved with ECG data.
5. (Optional) Click **Add Criteria** to add another criteria condition.
   The system log updates the list of entries and displays another criteria row.
6. Click **And** and select a logical operator to evaluate the new criteria condition to the previous criteria condition.
   For a description of each operator used to evaluate criteria conditions, see **Logical Operators** on page 43.
7. Repeat steps 2 through 6 for each additional criteria condition you want to add to the filter.
   The system log compares the entries that meet the last condition to the previous condition. The system log lists the entries that meet the two conditions. The system log repeats the process for each preceding criteria condition.

**Comparison Operators**

You can select a comparison operator to filter a number, a date, or text. For example, to see all entries
created after June 1, 2001, select **Greater than** and enter 06/01/2001. You can enter a date using the MM/DD/YYYY format or click the down arrow to select a date from the calendar.

You can filter for specific dates or for a range of dates. You cannot filter for specific times. For the purpose of filtering, the system log uses a time of 12:00 AM for all dates. To select a range of dates, use the Between operator.

<table>
<thead>
<tr>
<th>Comparison Operator</th>
<th>Description</th>
<th>Use with the Following Columns</th>
</tr>
</thead>
</table>
| Equal               | Lists the entries whose values for the column are the same as the selected value. | • Action  
• Date and Time  
• Description  
• Type |
| Not equal           | Lists the entries whose values for the column are not the same as the selected value. | • Action  
• Date and Time  
• Description  
• Type |
<table>
<thead>
<tr>
<th>Comparison Operator</th>
<th>Description</th>
<th>Use with the Following Columns</th>
</tr>
</thead>
</table>
| Greater than               | Lists the entries whose values for the column follow or are larger than the selected value. | • Action  
• Date and Time  
• Description  
• Type |
| Less than                  | Lists the entries whose values for the column precede or are smaller than the selected value. | • Action  
• Date and Time  
• Description  
• Type |
| Greater than or equal to   | Lists the entries whose values for the column are the same, follow, or are larger than the selected value. | • Action  
• Date and Time  
• Description  
• Type |
| Less than or equal to      | Lists the entries whose values for the column are the same, precede, or are smaller than the selected value. | • Action  
• Date and Time  
• Description  
• Type |
| Between                    | Lists the entries whose values for the column are between the first and last selected values. Use to specify a range of dates, numbers, or text. | • Action  
• Date and Time  
• Description  
• Type |
| Not between                | Lists the entries whose values for the column that are before the first selected value or after the last selected value. | • Action  
• Description  
• Type |
| Contains                   | Lists the entries whose values for the column includes the selected value. | • Action  
• Description  
• Type |
| Not contains                | Lists the entries whose values for the column do not include the selected value. | • Action  
• Description  
• Type |
| Begins with                | Lists the entries whose values for the column starts with the selected value. | • Action  
• Description  
• Type |
| Ends with                  | Lists the entries whose values for the column ends with the selected value. | • Action  
• Description  
• Type |
| Is null                    | Lists the entries whose values for the column do not exist. | • Action  
• Date and Time  
• Description  
• Type |
Logical Operators

Select the logical operator from the list of operators that you want to use to compare two criteria conditions. The system log outlines the criteria conditions and connects the conditions with a line.

When a filter has more than two criteria conditions, the system log compares the last criteria condition with the criteria condition that precedes it. The system log then compares the entries that satisfy that condition with the criteria condition that precedes it. Each criteria condition that precedes the results continues to filter the entries that appear in the system log.

<table>
<thead>
<tr>
<th>Logical Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>And</td>
<td>Display the entry when the criteria in the first and the second conditions are both met.</td>
</tr>
<tr>
<td>And not</td>
<td>Display the entry when the criteria in the first condition is met and the criteria in the second condition is not met.</td>
</tr>
<tr>
<td>Or</td>
<td>Display the entry when either the criteria in the first condition or the criteria in the second condition are met.</td>
</tr>
<tr>
<td>Or not</td>
<td>Display the entry when the criteria in the first condition is met or when the criteria in the second condition is not met.</td>
</tr>
</tbody>
</table>

Comparison Operators

- **Not is null**: Lists the entries whose values for the column exist.
- **Is empty**: Lists the entries whose values for the column do not appear in the system log.
- **Not is empty**: Lists the entries whose values for the column appear in the system log.
- **Any of**: Lists the entries whose values for the column include the selected items.
- **None of**: Lists the entries whose values for the column do not include the selected items.

Use with the following columns:

- Action
- Date and Time
- Description
- Type
Removing Filters

If you filter the system log and then exit 12-Lead Transfer Station before removing the filter, 12-Lead Transfer Station remembers the filter settings. 12-Lead Transfer Station displays the entries using filter settings the next time you use the system log.

You can return a single column to its unfiltered state or remove all the filters.

**CAUTION**
The system log removes the criteria condition and each criteria condition that appears below the criteria condition.

To return a column to its unfiltered state
1. Identify the criteria condition you want to remove.
2. Click Remove Criteria.

To remove all filters
- On the first criteria condition row, click Remove Criteria.

Clearing System Log Entries

You can clear the contents of the system log from the 12-Lead Transfer Station database.

To clear the system log entries from the database
1. From the File menu, click Clear Log.
   12-Lead Transfer Station displays a message to confirm the deletion.
2. Click Yes to delete the system log entries or No to cancel this operation.
   If you click Yes, 12-Lead Transfer Station clears the system log and adds an entry that notes this operation.

System Log Messages

The following table provides an overview of common messages. The table also provides an explanation of the messages, which can help in troubleshooting.
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Possible Issue</th>
</tr>
</thead>
</table>
| Fail to forward to destination | ECG ID  
ECG acquired Date and Time stamp  
File Name: *HeartStart MRx data file name*  
Destination type: (Fax, Printer, Email, hub, or application destinations: TraceMasterVue, 12-Lead Transfer Station, or DatamedFT)  
Destination: value  
Value = <empty> if no string | Successfully processed the HeartStart MRx data but cannot process the destination information.  
Possible reason:  
• No Fax number for Fax destination  
• No URL for TraceMasterVue or 12-Lead Transfer Station destination  
• Invalid path to DataMedFT Inbox  
• Invalid URL  
• No connection to URL |
| ECG saved | ECG ID  
ECG acquired Date and Time stamp  
imported from data card  
File name: *GUID file name.XML* | 12-Lead Transfer Station imported the data from the data card, processed the ECG data, and saved it to database. |
| ECG saved | ECG ID  
ECG acquired Date and Time stamp  
Imported from HeartStart MRx  
File name: *GUID file name.XML* | 12-Lead Transfer Station imported the data from HeartStart MRx, processed the ECG data, and saved it to database.  
12-Lead Transfer Station uses ECG ID, patient ID and acquired date and time to identify the entry.  
If 12-Lead Transfer Station receives a duplicate 12-lead report, it overwrites the existing entry. |
| ECG saved | ECG ID  
ECG acquired Date and Time stamp  
Imported from 12-Lead Transfer Station  
File name: *GUID file name.XML* | 12-Lead Transfer Station received data from another 12-Lead Transfer Station.  
12-Lead Transfer Station processed the ECG data, and saved it to database. |
| ECG faxed | ECG ID  
Printer Name: *fax number*  
File name: *GUID file name.XML* | 12-Lead Transfer Station sent the 12-lead report to the fax service. The fax service continues to retry faxing depending on how it’s configured. However, 12-Lead Transfer Station does not know if the fax was successful. Refer to the Microsoft Fax Console for the status of the fax transmission.  
Possible reasons for failure are:  
• Fax machine is out of paper.  
• Fax machine is out of service.  
• Fax machine is not plugged in.  
Each fax number has its own entry in the log. |
## Working with the System Log

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Possible Issue</th>
</tr>
</thead>
</table>
| ECG printed  | ECG ID
Printer Name: *Printer name*
File name: *GUID file name.XML* |
|              | 12-Lead Transfer Station sent the 12-lead report to the printer. The 12-lead report remains in the print queue until it prints. However, 12-Lead Transfer Station does not know if the print job was successful. Refer to the Microsoft printer queue for the status of the printer. Possible reasons for failure are:
  - Printer is out of paper.
  - Printer is out of service.
  - Printer is unplugged.
Each printer name has its own entry in the log. |
| ECG forward  | ECG ID
ECG acquired Date and Time stamp
Sent: *TraceMaster HTTP address* |
|              | 12-Lead Transfer Station sent the 12-lead report to TraceMaster. Each TraceMaster name has its own entry in the log. |
| ECG forward  | ECG ID
ECG acquired Date and Time stamp
Sent to 12-Lead Transfer Station: *HTTP address* |
|              | 12-Lead Transfer Station sent the 12-lead report to 12-Lead Transfer Station. Each 12-Lead Transfer Station name has its own entry in the log. |
| Fail to forward | Connection failed: Please check modem connection or RAS service. |
|              | 12-Lead Transfer Station cannot connect to the modem. The modem cannot dial out or connect to TraceMaster. Possible reason for failure is: no dial tone. |
| Fail to forward | ECG ID
ECG acquired Date and Time stamp
Rejected by TraceMaster: *TraceMaster name*
Error code: 1013 |
|              | TraceMaster rejected the 12-lead report because it contained the .05 - 40 Hz 12-lead filter setting. TraceMaster does not support this filter setting. |
| ECG deleted  | Delete *XX* 12-lead ECG |
|              | 12-Lead Transfer Station deleted *xx* number of 12-lead reports due to a user initiated activity. |
| ECG emailed  | ECG ID
Time of day: 11:05:22
Sent *recipient.name@philips.com* |
|              | 12-Lead Transfer Station sent the 12-lead report to the email address. However, 12-Lead Transfer Station does not know if the email was received. Possible reasons for failure are:
  - Email client is out of service.
  - Email address was incorrect.
  - SMTP server is down or unavailable.
Each email address has its own entry in the log. |
Setting Up the 12-Lead Transfer Station Web Service

This section provides an overview of setting up a machine to support the 12-Lead Transfer Station. Recommended security practices appear in the appropriate topics.

The following information assumes that an IT professional performs the tasks. The information highlights only the configuration required to support 12-Lead Transfer Station. Please refer to Microsoft documentation for all Internet connection, installation, and configuration details.

**NOTE** If you use Web Service, confirm that IIS is installed and running before you install 12-Lead Transfer Station. Configure the system as an Application Server and install Internet Information Services (IIS). For more information, see the topic [Setting up Internet Information Services (IIS)] on page 49.

If you do not use Web Service and do not use IIS, the installation displays an error message. Click Ignore to continue.

**Overview**

This section has the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Providing Internet Connection Services</td>
<td>48</td>
</tr>
<tr>
<td>Choosing an Operating System</td>
<td>48</td>
</tr>
<tr>
<td>Reading the Release Notes</td>
<td>48</td>
</tr>
<tr>
<td>Confirming System Hardware Requirements</td>
<td>48</td>
</tr>
<tr>
<td>Installing the Operating System</td>
<td>49</td>
</tr>
<tr>
<td>Running Transfer Station Service Manager as a Service</td>
<td>51</td>
</tr>
<tr>
<td>Installing a Modem, Printer, and Fax</td>
<td>51</td>
</tr>
<tr>
<td>Using Bluetooth Wireless Transmissions</td>
<td>52</td>
</tr>
</tbody>
</table>
Providing Internet Connection Services

HeartStart MRx communicates with 12-Lead Transfer Station through the Internet. To receive 12-lead reports from HeartStart MRx, you need to have a World Wide Web server. The Web server requires the following services:

- **Internet Service Provider (ISP):** The ISP provides a connection to the Internet. The ISP must supply a static or permanent IP address to support your domain name.

- **Domain Name Service (DNS):** The DNS provides a domain name for the IP address. Many ISPs can obtain and register a domain name for you, or you can do it yourself. For more information, see the Accredited Registrar Directory at the InterNIC Web site (http://www.internic.net).

- **Internet Information Services (IIS):** The IIS sends and receives information from the Internet. Although IIS ships with the Windows application, Windows does not automatically install IIS when you install the operating system. You must install IIS separately. The Microsoft Web site at http://www.microsoft.com/iis has additional information. For more information, see Setting up Internet Information Services (IIS).

- **Simple Mail Transfer Protocol (SMTP):** The SMTP service delivers outgoing email messages. If you want to send 12-lead reports through an Auto Send List, Philips Medical Systems recommends that you install SMTP when you install IIS. You must install SMTP separately from the Windows Control Panel. The SMTP installation creates a default SMTP configuration. You can use IIS Manager to customize the SMTP configuration. For more information, see Setting up the Simple Mail Transfer Protocol.

Choosing an Operating System

The 12-Lead Transfer Station machine can use either of the following operating systems:

- Windows XP Professional, SP2 running IIS 5.1, or higher
- Windows Server 2003, SP2 running IIS 6 Standard Edition, or higher

If you want to send 12-lead reports through an Auto Send List, Philips Healthcare recommends that you install SMTP when you install IIS. You can install SMTP on the same machine as 12-Lead Transfer Station or on the Intranet.

Reading the Release Notes

The ReadMe file, which is included in the 12-Lead Transfer Station installation, contains any changes to the documentation that is too new to be included in this manual. These changes might influence your installation. Read the ReadMe file before you install 12-Lead Transfer Station.

Confirming System Hardware Requirements

Review Microsoft documentation to ensure that your hardware supports the chosen operating system. Please check with Microsoft for their current recommendations.

For 12-Lead Transfer Station software and hardware requirements, see System Requirements on page 6.
Storage Requirements

The MSDE 2000 is the database that stores the 12-lead reports and configuration information. It can store up to 2 GB of data. If you assume that an average 12-lead report is approximately 60 KB, the MSDE database can store approximately 30,000 12-lead reports (2 GB/60 KB =30,000, approximately). Contact Customer support if you plan to store more than this amount.

Optional Hardware

Depending on your needs, you might want to use additional hardware such as a tape backup device, fax modem, and printer.

- **Tape or other backup device**: Philips Healthcare recommends that you install a tape or other backup device. Store the backup information at a separate location. Create a plan to recover information in the case of a software or hardware failure.

- **Modem or fax machines**: If you plan to use Fax Service to forward 12-lead reports from HeartStart MRx, Philips Healthcare recommends that you dedicate a modem to the 12-Lead Transfer Station. If multiple applications on the same computer use the same modem, you might experience service conflicts. For example, a 12-Lead Transfer Station trying to fax a 12-lead report and a workstation trying to fax a scanned document could create a conflict. The modem must be on the same computer as the 12-Lead Transfer Station.

- **Printer**: If you plan to print 12-lead reports, install a printer on the same computer or network as 12-Lead Transfer Station.

Installing the Operating System

The purpose of this section is to provide you with instructions specific to setting up the machine to support 12-Lead Transfer Station. You are responsible for making all decisions for supporting your business and security needs. The Microsoft installation documentation and Web site provide instructions for installing and configuring a secure machine. After installing the operating system, make sure that you install all the latest security patches and updates.

In addition to configuring the system to meet your business and security needs, include the following configurations:

- Configure the system as an Application Server and install Internet Information Services (IIS). For more information, see Setting up Internet Information Services (IIS) on page 49.
- Do not delete or rename the IIS default Web site page. 12-Lead Transfer Station uses its settings.
- You do not need to install Active Directory service, DHCP server, or DNS server, Front Page extensions, or ASP.

To set up email for use with Auto Send Lists, set up the SMTP server. For more information, see Setting up the Simple Mail Transfer Protocol on page 50.

To receive 12-lead reports on a system running Windows XP Professional SP2, change the Firewall settings. For more information, see Additional Instructions for Windows XP Professional SP2 on page 50.

Setting up Internet Information Services (IIS)

12-Lead Transfer Station uses Internet Information Services (IIS) to send and receive information from the Internet. Although IIS ships with the Windows application, Windows does not automatically install IIS when you install the operating system. You must install IIS separately.
During IIS installation, IIS installs optional components such as Common Files, Documentation, and the Internet Information Services snap-in. You can choose not to install the optional components. However, not installing some components can decrease IIS functionality or disable IIS services. If you are unfamiliar with the optional components, install IIS with the default settings. After you install IIS, you can view “Installing IIS Optional Components” in the IIS online documentation for more information.

**NOTE**
You might need your Windows Server 2003 or Windows XP installation CD to complete the setup.

**To install IIS**

1. From the Windows Start menu, click **Control Panel**, and then double-click **Add or Remove Programs**.
2. Click **Add/Remove Windows Components**. Windows displays the Windows Components Wizard window.
3. Select **Internet Information Services** and click Next.
4. Follow the on-screen instructions.

### Setting up the Simple Mail Transfer Protocol

The Simple Mail Transfer Protocol (SMTP) service delivers outgoing email messages. Windows does not automatically install SMTP when you install IIS. Verify that your Internet Service Provider (ISP) supports SMTP.

You must install IIS separately using the Windows Control Panel. The SMTP installation creates a default SMTP configuration. You can use IIS Manager to customize the SMTP configuration.


### Additional Instructions for Windows XP Professional SP2

Microsoft enhanced the security settings for the Firewall in Service Package 2 (SP2). To receive 12-lead reports on a system running Windows XP Professional SP2, make the following changes to the Firewall settings.

If you use a different firewall, refer to the documentation for that product.

**To change Firewall settings**

1. From the Windows Start menu, click **Control Panel**.
2. Double-click **Security Center**.
3. Click **Windows Firewall**.
4. Click the **Exceptions** tab.
5. Click **Add Port**.
6. In **Name**, type **HTTP-12LTS**, or another name of your choice.
7. In **Port number**, type **80**.
8. Select **TCP**.
9. Click **OK**.
10. In the Windows Firewall window, click **OK**.
11. Exit from the Security Center window.
Running Transfer Station Service Manager as a Service

The default installation delivers 12-lead reports to 12-Lead Transfer Station only when a user is logged on and running 12-Lead Transfer Station. If you need to receive 12-lead reports on a 24 hour/7 days schedule, you must set up Transfer Station Service Manager. You can configure the service from the 12-Lead Transfer Station application or from Windows.

To set up the service from 12-Lead Transfer Station application
1. On the Configuration menu, click Transfer Station Service Manager. The Configuration – Transfer Station Service Manager window lists the user name for the 12-Lead Transfer Station machine.
2. In Password, type the password for the user name. This is a required field.
3. In Confirm password, type the password for the user name again.
4. In Startup type, select Automatic.
5. Click OK.
6. On the File menu, click Transfer Station Service Manager, then click Start.

To set up the service from Windows
1. Complete the normal installation.
2. From the Windows Start menu, click Run.
3. In the Open field, type services.msc.
4. In Service Manager, right click Transfer Station Service Manager.
5. Click Properties.
6. In Startup type on the General tab, select Automatic.
7. In the Log on as on the Log On tab, select This account.
   The account must have administrator privileges on this machine. It must require a password.
   If 12-Lead Transfer Station forwards 12-lead reports to a printer or fax, the devices must be configured for this account.
8. Complete the account and password information.
9. Unless you have a specific reason, do not change the entries in the Recovery or Dependencies tabs.
10. If you want to start the service now, click the General tab and click Start.
    - or -
    Reboot the computer. The service will start.

Installing a Modem, Printer, and Fax

You will need your modem installation CD, printer installation CD, and the Windows CD to install the components.

Make sure that the 12-Lead Transfer Station has the latest fax drivers installed. See the Microsoft Web site at: http://www.microsoft.com for additional information.

To install a modem, printer, and fax
1. Install the modem software driver from your modem installation CD.
2. Install the printer software driver from your printer installation CD.
3 Install the fax component from your Windows CD.
4 Once the fax component is installed and set up, start an application, such as Microsoft Word, and fax a file. The first time you fax a file, the Setup wizard runs and provides instructions on correctly faxing a file. Make sure to set up the default fax orientation to landscape.
5 Set up the printer through the Windows Control Panel. Once the printer is set up, verify printing by printing a file.

Using Bluetooth Wireless Transmissions

To transfer the information from the defibrillator to 12-Lead Transfer Station, you must set up the Bluetooth wireless data transmission on the HeartStart MRx and the receiving computer that has 12-Lead Transfer Station installed.

If the computer is not equipped with Bluetooth, the computer requires a Bluetooth dongle with an USB connector. The dongle connects the computer with 12-Lead Transfer Station installed and the defibrillator.

**CAUTION**
HeartStart MRx is capable of communicating via Bluetooth with nearby devices such as computers, laptops, tablets, and mobile devices. Each device has a unique set of features and configuration options. In order to ensure reliable transmissions, familiarize yourself with the Bluetooth configuration choices of each. Some choices (either default or chosen by the user) could prevent receipt of data from HeartStart MRx. For example, it is recommended that you disable features such as “Start discovery every 10 minutes”. Enabling this option could interfere with transmissions from HeartStart MRx.

When you install the Bluetooth software on the receiving computer, the process creates the Bluetooth configuration folder on the receiving computer. The configuration creates the folder based on the logon of the user who configured Bluetooth. For example, the folder for user1 is typically at the following location:

- `C:\Document and Settings\user1\My Documents\Bluetooth Exchange Folder`.

When HeartStart MRx transmits the data to 12-Lead Transfer Station, the defibrillator creates subfolders on the computer to store the transmitted data.

HeartStart MRx 12-Lead Reports might contain information which could be considered Patient Healthcare Information (PHI) or patient identifiable data. This information can be transferred from the HeartStart MRx. Please handle the information in accordance with HIPAA or your local patient privacy requirements.

This section includes the following topics:

- [HeartStart MRx Bluetooth Option Prerequisites](#) on page 52
- [Setting Up the Bluetooth Software and Adapter on the Computer](#) on page 53
- [Sending the Bluetooth Wireless Transmission](#) on page 54

**HeartStart MRx Bluetooth Option Prerequisites**

The Bluetooth card on HeartStart MRx is inside of the defibrillator. Make sure that you purchased HeartStart MRx with the appropriate Bluetooth option or upgrade.

For detailed information on setting up the HeartStart MRx defibrillator for Bluetooth wireless transmission, see the following documentation:

- [HeartStart MRx Instructions for Use Addendum, version 9.xx](#)
- [HeartStart MRx M3535A, M3536A Instructions for Use, version 7.xx](#)
Using Bluetooth Wireless Transmissions

Setting Up the Bluetooth Software and Adapter on the Computer

Setting up the Bluetooth software and adapter involves the following tasks:

- Installing the Bluetooth software and adapter
- Pairing the HeartStart MRx Bluetooth option with the computer
- Testing the connection

HeartStart MRx supports File Transfer Profile Server 1.1 and was tested with the following Bluetooth stacks: Toshiba™ 4.20.01, IVT™ 2.1.2.0 (Product)/05.04.11.20060301 (stack) and Widcomm™ 4.0.1.2400. For other Bluetooth stacks, review your user documentation to see if File Transfer Profile Server 1.1 is supported. If not, it is recommended that you install drivers that support File Transfer Profile Server 1.1.

During the following tasks, make sure that the defibrillator and the 12-Lead Transfer Station computer are within Bluetooth transmission range, usually within 30 feet of each other.

To install the Bluetooth software and adapter

- Refer to your Bluetooth software and adapter documentation.

NOTE

The Bluetooth configuration creates the folder based on the logon of the user who configured Bluetooth. For example, if you have the administrator logon, the default folder location is typically: C:\Document and Settings\Administrator\My Documents\Bluetooth Exchange Folder. If the user who receives the wireless transmission is not the administrator, you can change the path to point to that user’s Bluetooth exchange folder.

To specify the location of Bluetooth Exchange Folder

- Refer to your Bluetooth software and adapter documentation.

To pair the HeartStart MRx Bluetooth option with the computer

1. On HeartStart MRx, place the defibrillator in the Data Management mode.
2. On the menu, select Bluetooth Devices.
3. Scroll to Add Device and press the Enter button.
   The defibrillator searches for your computer.
   If your computer is not listed after the search, your computer Bluetooth is not enabled or set up correctly. Refer to your Bluetooth documentation to troubleshoot the setup.
4. Select your computer and press the Enter button.
5. Enter a passkey for the Bluetooth option.
   The passkey is a user-defined character sequence, such as 000, or 1234, etc. Use the HeartStart MRx documents listed for HeartStart MRx Bluetooth Option Prerequisites on page 52.
6. In the notification area of the taskbar, immediately watch for a pop-up message.
7. Click the pop-up message.
8. Enter the same Bluetooth passkey that you entered on HeartStart MRx in Step 5.
   HeartStart MRx and the computer have a Bluetooth connection. You are ready to test the Bluetooth connection.
9. On the Data Management menu, select File Transfer and then press the Enter button.
   HeartStart MRx displays the transmission test passed message.
10 Scroll to Exit and press the Enter button.

**Sending the Bluetooth Wireless Transmission**

You can download a 12-lead report to the computer through Bluetooth wireless transmission while HeartStart MRx is in the Data Management mode or while HeartStart MRx monitors the patient’s 12-lead. For more information, see the appropriate chapters in the following guides:

- *HeartStart MRx Instructions for Use Addendum*, version 9.xx
- *HeartStart MRx M3535A, M3536A Instructions for Use*, version 7.xx
Troubleshooting

This section provides an overview of how 12-Lead Transfer Station works and information on troubleshooting.

Overview

This section has the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using 12-Lead Transfer Station</td>
<td>55</td>
</tr>
<tr>
<td>Parts of 12-Lead Transfer Station</td>
<td>55</td>
</tr>
<tr>
<td>12-Lead Transfer Station Inboxes</td>
<td>56</td>
</tr>
<tr>
<td>Troubleshooting 12-Lead Reports</td>
<td>56</td>
</tr>
<tr>
<td>Troubleshooting with the System Log</td>
<td>59</td>
</tr>
</tbody>
</table>

Using 12-Lead Transfer Station

12-Lead Transfer Station runs on a Windows Server 2003 or Windows XP Professional with an Internet Information Service (IIS) Web server. It receives 12-lead reports from the Philips HeartStart MRx Monitor/Defibrillator. 12-Lead Transfer Station processes, stores, and displays the 12-lead reports. You can also send 12-lead reports to other applications, fax machines, printers, and email addresses.

HeartStart MRx uses a cell phone to send a stream of data containing the 12-lead report and destination information to the 12-Lead Transfer Station server.

Parts of 12-Lead Transfer Station

There are four parts to the 12-Lead Transfer Station:

- HTTP Service – IIS hands over the received data from the HeartStart MRx or another 12-Lead Transfer Station to HTTP service. HTTP saves the data in the appropriate inbox.
- Inbox Watcher Service – Monitors the TSInbox and the MRxInbox. Inbox Watcher Service parses the data into separate files and moves the data from the inbox into the database and Backup folder.
- MSDE 2000 – The database stores the 12-lead report and configuration information.
- 12-Lead Transfer Station application – Displays 12-lead reports and system log information, which shows all 12-Lead Transfer Station activity. The application provides the ability to configure 12-Lead Transfer Station to send 12-lead reports automatically and manually.
12-Lead Transfer Station Inboxes

There are two inboxes in 12-Lead Transfer Station: TSInbox and MRxInbox. The inboxes receive the data from the HeartStart MRx or another 12-Lead Transfer Station.

The MRxInbox default installation directory is C:\Program Files\Philips\HeartStart\12-Lead Transfer Station\MRxInbox

The TSInbox default installation directory is C:\Program Files\Philips\HeartStart\12-Lead Transfer Station\TSInbox

The Inbox Watcher Service monitors the inboxes and checks for activity. By default, Inbox Watcher Service checks for activity every 6 seconds. When the MRxInbox receives a 12-lead report, Inbox Watcher separates the data into the two component files – the Destination instruction and the actual 12-lead report.

- If 12-Lead Transfer Station cannot decipher the 12-lead report or otherwise fails to process a 12-lead report, 12-Lead Transfer Station displays an error message in the system log. 12-Lead Transfer Station moves the 12-lead report to the backup folder and saves the 12-lead report. The backup folder is a sub-folder of MRxInbox.
- If 12-Lead Transfer Station can process the 12-lead report, 12-Lead Transfer Station imports the 12-lead portion into the database. 12-Lead Transfer Station then processes the destination information and saves the 12-lead report in the backup folder.
- If HeartStart MRx included instructions for an additional destination, 12-Lead Transfer Station forwards the 12-lead report according to the instructions.

TIP You can configure the Inbox Watcher Service to automatically send 12-lead reports when 12-Lead Transfer Station is not running. For more information, see Running Transfer Station Service Manager as a Service on page 51.

Troubleshooting 12-Lead Reports

If you are troubleshooting the installation, see 12-Lead Transmission Implementation Guide.

When a 12-lead report was not sent to its destination, first check the system log for errors. For help using system log, see Troubleshooting with the System Log on page 59. If there are errors, use the table in System Log Messages on page 44 to understand and correct the problem.

Use following instructions to guide you through troubleshooting 12-Lead Transfer Station:

- Are you connected to a database? on page 56
- Did 12-Lead Transfer Station receive the 12-lead report? on page 57
- Does an Auto Send List exist? on page 57
- Is the destination configured? on page 57
- Is the destination a TraceMasterVue or 12-Lead Transfer Station application? on page 58
- Is the destination DatamedFT software? on page 58
- Is the destination a fax machine? on page 58
- Is the destination a printer? on page 58
- Is the destination an email address? on page 58
- Confirm that the HTTP service is running, on page 58
- Determine the source of the Inbox service error, on page 59

Are you connected to a database?

You can select the name of a local database or a database that is on the Intranet.
On the Configuration menu, click **General**.

2. In **Database server name**, select the name for a database server.

3. Click **OK**.

To set up a database on the Intranet, contact the IT person for the 12-Lead Transfer Station site.

**Did 12-Lead Transfer Station receive the 12-lead report?**

1. Click **View System Log** on the toolbar of 12-Lead Transfer Station to display the system log. The log should show **Saved ECG** for that ECG ID with the date and time when the action occurred.

2. If the ECG was received, check to see if there are error messages for the transmission. To understand and correct the problem, see **System Log Messages** on page 44.

3. If the 12-lead report was received and there are no error messages, continue with **Does an Auto Send List exist?** on page 57.

4. If the 12-lead report was not received, continue with **Confirm that the HTTP service is running**, on page 58.

**Does an Auto Send List exist?**

If this is a destination other than one specified in the HeartStart MRx routing file, you configure an Auto Send List.

1. On the Configuration menu, click **Auto Send Lists**.

2. In the Configuration – Auto Send Lists window, click in the **Name** field to confirm that an Auto Send List exists.

3. Select the Auto Send List name. 12-Lead Transfer Station lists the destinations in the Summary area.

4. If an Auto Send List exists, continue with **Is the destination configured?** on page 57.

**Is the destination configured?**

You need to complete destination settings for all devices, whether they are HeartStart MRx specified or 12-Lead Transfer Station specified. Review the appropriate window that is accessible from the Configuration – Auto Send Lists window.

1. On the Configuration menu, click **Auto Send Lists**.

2. If the destination is an application, click the down arrow in the **Application** field.

   - **Is the destination a TraceMasterVue or 12-Lead Transfer Station application?** on page 58. Or, see **Is the destination configured?** on page 57.
   - If the application name does not identify the type of destination, select **Add** to configure the destination. See **Setting Up Application Destinations** on page 16.
   - If the Configuration – Application window is complete, continue the next appropriate step.

3. If the destination is a fax, click the down arrow in the **Fax** field.

   - **Setting Up Fax Destinations** on page 18.

4. If the destination is printer, click the down arrow in the **Printer** field.

   - **Adding a Printer in Windows** on page 20.

5. If the destination is an email address, click the down arrow in the **Email address** field.

   - **Setting Up Email Address Destinations** on page 21.
Is the destination a TraceMasterVue or 12-Lead Transfer Station application?

If the destination is a TraceMasterVue, or 12-Lead Transfer Station application, confirm that the fields in the Network connection area are complete. If you have any doubts about the settings, contact the IT person at the receiving site.

If the steps in Is the destination configured? on page 57 did not solve the problem, the problem is probably on the receiving end. Contact the IT person for the site and request their help.

Is the destination DatamedFT software?

If the destination is DatamedFT, confirm that the location is correct for your installation.

If the destination is correct, verify that a translated ECG was created in the DatamedFT outbox. The default outbox location is C:\datamedFT\EKGtoMuse.

If the steps in Is the destination configured? on page 57 did not solve the problem, the problem is probably on the receiving end. Contact the IT person for the site and request their help to troubleshoot the DatamedFT application or associated ECG host, such as a GE MUSE application.

Is the destination a fax machine?

Confirm that the fax is set up in the Windows Fax Console. Confirm with the receiving site that the fax is ready to receive.

Is the destination a printer?

Confirm that the printer is ready to print.

• Does it have paper?
• Is it turned on?
• Display the Windows Printer and Faxes window and confirm that the status is READY.

Is the destination an email address?

Confirm that the email application or email service is installed or configured for the 12-Lead Transfer Station. Confirm that the SMTP server address is correct in the Configuration – General window. Contact the IT person for the SMTP site and request their help.

Confirm that the HTTP service is running.

Type the following URL in the browser Address field:
http://machinename/ems/MRtest.mrx?SourceName=test
where machinename is the domain name or IP address of the computer running 12-Lead Transfer Station.

If you see the following window, HTTP service is set up properly.
If the service is not running, restart IIS or check the IIS log to make sure that the IIS is configured properly.
If the service is running and the 12-lead report was not received, the problem might be in the HeartStart MRx transmission or that the Inbox service is not running.

**Determine the source of the Inbox service error.**

1. Navigate to the MRxInbox folder.
   The default path to the MRxInbox is C:\Program Files\Philips\HeartStart\12-Lead Transfer Station\MRxInbox.
2. If the 12-lead report is in the inbox, the Inbox service might not be running. See step 3 for help.
   - or -
   If the 12-lead report is not in the inbox, the problem might be with the HeartStart MRx transmission.
3. Verify that the Inbox service is running
   a. From the Windows Start menu, click **Control Panel**.
   b. Double-click **Administrative Tools**.
   c. Double-click **Services**.
   d. Find **Transfer Station Service Manager**.
   e. If the status is Stopped, right-click **Transfer Station Service Manager** and click **Start**.
   If the status is Started, the problem is with the HeartStart MRx transmission.

**Troubleshooting with the System Log**

To view 12-Lead Transfer Station activity, click **View System Log** on the toolbar or click **System Log** on the View menu. The system log displays two types of messages: Information and Error.

The system log has tools to change the way 12-Lead Transfer Station displays information. You can sort, group, and filter the list of entries. A filter shows only those entries that meet the criteria you select.

You change the way the system log displays information when you want to analyze data or search for specific information. For help using the tools, see **Working with the System Log** on page 39. For help troubleshooting the system log entries, see **System Log Messages** on page 44.
## Glossary

<table>
<thead>
<tr>
<th>A</th>
<th>Automatic transfer</th>
<th>The process where the 12-Lead Transfer Station forwards the 12-lead ECG report according to instructions received from the HeartStart MRx and Auto Send Lists.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Send List</td>
<td>The lists configured in the Configuration – Auto Send Lists window. An Auto Send List designates the destinations that receive 12-lead ECG reports automatically.</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>Bluetooth*</td>
<td>A short-range wireless technology that uses radio links between HeartStart MRx and mobile computers, mobile phones, and other portable devices.</td>
</tr>
<tr>
<td>C</td>
<td>Card reader</td>
<td>Hardware that reads data from a computer flash data card.</td>
</tr>
<tr>
<td>D</td>
<td>DNS</td>
<td>Acronym for Domain Name Service. The Internet utility that implements the domain name addresses (such as bluestem.prairienet.org) and IP addresses (such as 192.17.3.4). DNS servers access and maintain databases that contain IP addresses. The domain name address is used by human users. It is automatically translated into the numerical IP address, which is used by the packet-routing software.</td>
</tr>
<tr>
<td></td>
<td>Data card</td>
<td>A computer storage device used for recording and storing data. The HeartStart MRx can store the 12-lead ECG on a data card.</td>
</tr>
<tr>
<td></td>
<td>Destination</td>
<td>The intended recipient of a 12-lead report. The destination can be a TraceMasterVue system, DatamedFT software, a 12-Lead Transfer Station, an email address, a printer, and a fax machine.</td>
</tr>
<tr>
<td></td>
<td>Domain name</td>
<td>An address of a network connection in the format that identifies the owner of that address in a hierarchical format: server.organization.type. For example, <a href="http://www.whitehouse.gov">www.whitehouse.gov</a> identifies the Web server at the White House, which is part of the U.S. government.</td>
</tr>
<tr>
<td></td>
<td>Domain name address</td>
<td>The address of a device connected to the Internet or any other TCP/IP network, in the hierarchical system that uses words to identify servers, organizations, and types, such as <a href="http://www.logos.net">www.logos.net</a>. See also TCP/IP.</td>
</tr>
<tr>
<td></td>
<td>Domain Name Service</td>
<td>See DNS.</td>
</tr>
<tr>
<td></td>
<td>Fax modem</td>
<td>A modem that sends (and possibly receives) data encoded in a fax format, which a fax machine or another modem decodes and converts to an image. Fax modems might be internal or external and might combine fax and conventional modem capabilities.</td>
</tr>
</tbody>
</table>
Firewall
A security system intended to protect an organization’s network against external threats, such as hackers, coming from another network, such as the Internet. A firewall prevents computers in the organization’s network from communicating directly with computers external to the network and vice versa. Instead, all communication is routed through a proxy server outside of the organization’s network, and the proxy server decides whether it is safe to let a particular message or file pass through to the organization’s network.

Internet Information Service (IIS)
Microsoft’s brand of Web server software, utilizing Hypertext Transfer Protocol to deliver World Wide Web documents. It incorporates various functions for security, allows for CGI programs, and provides for Gopher and FTP servers.

Internet Protocol
See IP.

Internet Service Provider (ISP)
A business that supplies Internet connectivity services to individuals, businesses, and other organizations. Some ISPs are large national or multinational corporations that offer access in many locations, while others are limited to a single city or region. Also called access provider, service provider.

IP
Acronym for Internet Protocol. The protocol within TCP/IP that governs the breakup of data messages into packets, the routing of the packets from sender to destination network and station, and the reassembly of the packets into the original data messages at the destination. IP corresponds to the network layer in the ISO/OSI model.

IP Address
Short for Internet Protocol address. A 32-bit (4-byte) binary number that uniquely identifies a host (computer) connected to the Internet to other Internet hosts, for the purposes of communication through the transfer of packets.

Manual transfer and view
The process where a 12-Lead Transfer Station user sends the 12-lead report to an Auto Send List, a TraceMasterVue system, a GE MUSE System, or a 12-Lead Transfer Station. This process is separate from the Automatic Transfer.

Microsoft Fax Console
The user interface for Microsoft Fax Service.

Microsoft Fax Service
A system service that provides fax services to local and remote network clients. Fax services include receiving faxes and faxing documents, fax wizard messages, and e-mail messages.

Net Bios
An application programming interface (API) that can be used by application programs on a local area network consisting of IBM and compatible microcomputers running MS-DOS, OS/2, or some version of UNIX.

Proxy Server
A firewall component that manages Internet traffic to and from a local area network (LAN) and can provide other features, such as document caching and access control. A proxy server can improve performance by supplying frequently requested data, such as a popular Web page, and can filter and discard requests that the owner does not consider appropriate, such as requests for unauthorized access to proprietary files. See also firewall.

Report tree
The list of available 12-lead ECG reports that are stored in the 12-Lead Transfer Station database. The left pane of the 12-Lead Transfer Station window displays the report tree.
### Simultaneous 12-lead ECG report
An ECG report that shows a 2.5 second simultaneous segment of ECG data for each lead, as well as the full ten seconds of captured data for a single lead. The 12-lead report presents data for each lead that was taken at exactly the same instant in time.

### System log
The log of 12-Lead Transfer Station activity. The system log is available from the View menu and toolbar in the 12-Lead Transfer Station window.

### TCP/IP
Acronym for Transmission Control Protocol/Internet Protocol. A protocol developed by the Department of Defense for communications between computers. It is the de facto standard for data transmission over networks, including the Internet.

### Time sequential 12-lead ECG report
An ECG report that shows a sequential sample of 2.5 seconds of ECG data from each of the twelve channels. The format has three rows of four channels of data, with a single channel at the bottom of the page. Each successive channel has the next 2.5 seconds of data of the total of 10 seconds of data.

### URL
Acronym for Uniform Resource Locator. An address for a resource on the Internet. URLs are used by Web browsers to locate Internet resources. A URL specifies the protocol to be used in accessing the resource (such as http: for a World Wide Web page or ftp: for an FTP site), the name of the server on which the resource resides (such as // www.whitehouse.gov), and, optionally, the path to a resource (such as an HTML document or a file on that server).

### web
A set of interlinked documents in a hypertext system. The user enters the web through a home page. See also World Wide Web.

### Work area
The right pane of the 12-Lead Transfer Station window. The work area displays the selected 12-lead report or the system log.

### World Wide Web
The total set of interlinked hypertext documents residing on HTTP servers all around the world. Documents on the World Wide Web, called pages or Web pages, are written in HTML (Hypertext Markup Language), identified by URLs (Uniform Resource Locators) that specify the particular machine and path name by which a file can be accessed, and transmitted from node to node to the end user under HTTP (Hypertext Transfer Protocol).
Customer Support

Philips Healthcare strives to provide you with excellent customer service and technical support. Software updates are available from the Help menu. Open the Help menu, and then select Check for Updates.

Customer Support

Customer support is available by email and by telephone.

Email product support is available in English only at: 12LTS.support@philips.com

For telephone assistance outside the United States, please call your sales representative or local sales office.

For telephone support in English only, you can call the following numbers between 9:00 AM and 5:00 PM, Pacific Time:

- 1-800-263-3342, in the United States
- 206-664-7745, outside the United States

Comments or Suggestions?

Please send your feedback and suggestions to 12LTS.support@philips.com

Supported Help

Customer support technicians provide help for the following:

- Explaining the proper use of 12-Lead Transfer Station features and answering your questions about how 12-Lead Transfer Station works.
- Explaining the proper installation and maintenance of 12-Lead Transfer Station.
- Assisting you in selecting and configuring card readers.
- Answering questions about managing the 12-Lead Transfer Station database.

Unsupported Help

Customer support technicians do not provide help for the following:

- Repairing hardware. The support technicians can help you determine if you have a hardware problem, but they cannot help you fix problems that are not related to 12-Lead Transfer Station software.
- Troubleshooting defibrillators. Please call Philips Customer Support and ask for defibrillator support.

Helping Us Help You

You can help our technicians give you good support by following these steps:

1. Call from a phone near your computer.
2. Have 12-Lead Transfer Station started.
3. Have the following information:
• Windows version.
• 12-Lead Transfer Station version number. This is available from the Help menu. Click About.
12-lead entries, saved 33
12-lead reports
  automatic transfer from HeartStart MRx 2
  automatic transfer to multiple destinations 2
change display format 26
Configuration menu 34
delete all reports 34
e-mail
  automatically 21
  manually 30, 31
fax
  automatically 18
  manually 29
fax reports 18
File menu 34
HeartStart MRx data card 28
import 27
manage 33
manual transfer to multiple destinations 2
obsolete entries 34
obsolete reports 34
print
  automatically 21, 36
  manually 30
report history 27
send to 12-Lead Transfer Stations 16
send to TraceMasters 16
simultaneous format 26
specific reports 34
time sequential format 26
view 26
work area 26
XML file 28
12-Lead Transfer Station 1, 7, 9
  application 55
Auto Send List destination 14
bank up data 4
components 55
configure Transfer Station Service Manager 51
connect to a database at a different location 57
database 14, 56
decipher 12-lead reports 56
default machine settings 14
destinations 2, 3, 12, 14, 26, 29
fax reports 18
forward reports manually 26
HTTP Service 55
import data from data cards 28
Inbox Watcher Service 55, 56
Inboxes 56
install 7
MRxInbox 56
MSDE 2000 55
print reports 20
purpose 2, 55
report tree 26
services
  automatic transfer from HeartStart MRx 2
  automatic transfer to multiple destinations 2
  manual transfer to multiple destinations 2
storage requirements 49
troubleshoot 56
TSInbox 56
12-Lead Transmission
  see 12-lead reports
overview 3
12-Lead Transmission Implementation Guide 56
A
Action 40
activate
  12-Lead Transfer Station 1, 7
  by e-mail 8
  by the Internet 7
later 9
applications 55
  12-Lead Transfer destination 33
  add 34
  Auto Send List 17
Configuration – Auto Send Lists 16
delete 35
edit 35
applications destination 16, 34
  Auto Send List 16
  Forward option 16
Applications field
  configure application destinations 17
  destinations 16
Auto Send List 11–12, 15, 61
  12-Lead Transfer destination 12, 14, 25
  Configuration-Application 16
default list 12, 15
defined 2, 11, 14
delete 23
destinations 11, 14, 15
edit 22
e-mail SMTP server 21
faxes 19, 21
forward 12-lead reports
  automatically 25
  manually 25
to destinations 12
forward reports manually 29
hub name 15
manage 22
send 12-lead reports
  automatically 11
  manually 12
to a fax machine 18, 19
to an e-mail address 21
to destinations 11
the HeartStart MRx hub 3
uses 11
automatic
  forward
    faxes 19, 21
    printers 20
transfer 61
  from HeartStart MRxs, overview 2
overview 2
B
backing up data 4
Bluetooth® 1, 52–54
  12-lead transmission 3
  example use illustrated 3
HeartStart MRx 52
C
card reader 61
Check for Updates 65
collapse entries 40
column
  re-order 39
  resize 39
components, required 5
Configuration 19, 21
Configuration – Auto Send Lists
  add e-mail addresses 21
  add printer to Auto Send List 20, 21
application destinations 16
e-mail 12-lead reports automatically 21
e-mail address destinations 16
fax 19
fax destinations 16, 18
printer destinations 16
Configuration – Email
Auto Send Lists 21
Configuration – Fax
configure fax option 19
Configuration – General
days to store ECG reports 14
print style 20
report history 27
time reports 33
Configuration menu
12-lead reports 34
configure 12-Lead Transfer Station 14
configure 16
Microsoft Fax Console 6
reply email address 14
simultaneous 12-lead ECG report 14
time sequential ECG report 14
configured destinations
Forward option 29
Configuring 9
customer support 65
D
data backup 4
data card 61
HeartStart MRx defibrillator 27
database 14, 57
at a different location 56, 57
back up 4
DatamedFT 3, 17, 58
12-Lead Transfer destination 2, 3, 12,
15, 25, 29
Auto Send List destination 15
Date and Time 40
default printer 30
delete
all reports 34
Auto Send List 23
obsolete 12-lead reports 34
obsolete reports 34
specific report 34
destinations 2, 3, 14, 15, 25, 26, 33, 61
12-Lead Transfer Station 12
add 34
add email address 36
add fax 35
Auto Send Lists 11, 12, 14, 29
Configuration menu 34
DatamedFT, send reports manually 25
delete email address 37
delete fax 36edit email address 37edit fax 36
fax reports manually 26
manage 33
management applications 34
manage email addresses 36
manage fax machines 35
manual 12
menu 34, 35, 36
printer 21, 36
dial-up connections 18
DNS, see Domain Name Service
Domain name 61
address 61
Domain Name Service 48, 61
DNS 61
download updates 65
E
ECG, configure report format 14
edit Auto Send List 22
e-mail
12-lead reports
automatically 14, 21
manually 14, 30
12-Lead Transfer destination 2, 3, 12,
15, 26, 29, 33
add destination 36
Auto Send List destination 15
SMTP server 21
Configuration – Auto Send Lists
Configuration – Email
delete destination 37
destination 36
edit destination 37
destination 36
e-mail attached 12-lead report manually 30
File menu 14, 30
IIS, see Internet Information Services
manually 14
reply address 14
requirements 21
send manually 21, 26
server 14
set attachment password 14
Email option 30
Emergency recovery
4 entries
collapse group 40
expand group 40
filter criteria 40
filter entries on system log 40
group by
Action 40
Date and Time 40
group criteria 40
group to sort by criteria 40
remove filter criteria 44
sort the display 40
F
fax
12-lead reports
automatically 18
manually 29
12-Lead Transfer destination 2, 3, 12,
15, 26, 29, 33
add destination 35
Auto Send List destination 15
available fax numbers 19, 21
Configuration – Auto Send Lists
delete destination 36
destination 35
edit destination 36
Fax Console
for Windows 2003 18
for Windows XP 19
fax forwarding 6
File menu 29
install 52
Microsoft Fax Console 18
Microsoft Fax Service 29
modem 6, 18, 61
requirements 18
retry settings 18
Send Fax Wizard 29
send manually 18, 29
sent from Auto Send Lists 19
sent from HeartStart MRx 19
Fax/Print option 29, 30
File menu
12-lead reports 34
delete 12-lead reports 34
Email 14, 30
Fax 29
Forward 15, 29, 30
Import 28
Print 12, 30
Save As 28
send 12-lead report to an email, fax, or
printer 12
filter 40–46
criteria 40
defined 39, 40
report tree 27
reports 27
system log
add 40
remove 44
firewall 62
Forward 29
File menu 15, 29
menu
Applications 29
Auto Send Lists 29
destinations 29
Email 30
Fax 29
Print 30
send 12-lead report to a configured destination 12
toolbar 29
forward 12-lead reports
automatically 11
manually 12

G
GE MUSE 3, 17, 58
group entries 40
collapse group 40
expand group 40
system log 40

H
hardware requirements 49
HeartStart MRx 28
Auto Send List 15
card, see data card
data card, reading 28
fax 19
hub name 15
send 12-lead reports 55
send report to printer 20
send reports to TraceMaster 16
HeartStart MRx Monitor/Defibrillator
see HeartStart MRx
HTTP Service 55
hub, defined 3

I
IIS, see Internet Information Services
import
12-lead reports 27
File menu 28
from HeartStart MRx card 28
Inbox 56
Watcher Service 55, 56
installation 5–10
modem 51
required components 5
system requirements 6
Internet Information Services 2, 6, 21, 48, 55
(IIS) 62
set up 49
SMTP 48
Internet Protocol 62
Internet Service Provider 62
choosing 48
IP 62
IP address 62
ISP, see Internet Service Provider
M
machine
configure general settings 14
set up 47–54
manage 12-lead reports 33–37
manual
email 12-lead report 30
fax 12-lead report 29
print 12-lead report 30
send 12-lead report 29
transfer and view 62
transfer overview 2
Microsoft
Fax Console 6, 18, 62
Fax Service 62
fax 29
modem, install 51
MRx, see HeartStart MRx
MRxInbox 56
MSDE 2000 55
N
Net Bios 62
New Connection Wizard 18
O
obsolete 12-lead reports 34
Operating System
choosing 48
installing 49
optional hardware 49
P
password protect an email attachment 14
postpone activation 9
Print 30
12-lead reports manually 30
default printer 30
File menu 12, 30
toolbar 12, 30
print style 20
printer
12-Lead Transfer destination 2, 3, 12,
15, 26, 29, 33
add 20
add to Auto Send List 21
Auto Send List destination 15, 20
Configuration – Auto Send Lists 16
configure print style in Configuration –
General 20
default 30
install 51
manage destination 21, 36
print reports manually 26
print style 20
remove from Auto Send List 36
Printers and Faxes
configure printers 20
window 19, 21
Proxy Server 62
R
registration assistance 7
re-order column 39
reply email address 14
Report History 14, 27
days reports are saved 27, 33
report tree 26
defined 62
filter reports display 27
use 26
resize column 39
S
Save As
save 12-lead report as XML 28
send 12-lead reports
automatically 11
manually 12, 29
Send Fax Wizard 29
Fax option 29
Simple Mail Transfer Protocol, see SMTP
simultaneous 12-lead ECG report 14, 63
format 26
SMTP 48
server 14, 21
setting up 50
sort system log 40
specific report entry 34
storage requirements 49
store ECG reports 14
system log 39–46, 59, 63
change display 39
filter 40
filter entries 40
group entries 40
grouping entries 40
messages 44
remove entry filters 44
re-order column 39
resize columns 39
sort entries 40
sort records 40
troubleshoot 59
troubleshoot log messages 56
view 27
system messages table 44
system requirements 6
12-Lead Transfer Station 6
operating system 48
optional hardware 49
T
TCP/IP 63
time sequential ECG report 14
12-lead report format 26
default format 14
defined 63
toolbar
  Forward a report 12, 29
  Import data 27
  Print a report 12
  View System Log 57
TraceMaster, receive HeartStart MRx reports 16
TraceMasterVue
  12-Lead Transfer destination 2, 3, 11, 12, 14, 25, 29
  Auto Send List destination 14
  forward reports manually 25
Transfer Station Service Manager
  Configuration menu 51
  default configuration 51
  start 51
  Windows service 51
troubleshooting 55–59
  Auto Send List exist? 57
  DatamedFT software? 58
  destination configured? 57
  email destination 58
  fax destination 58
  printer destination 58
  received the report? 57
  system log 56, 59
  messages 56
  system messages 44–46
  TraceMaster or 12-Lead Transfer application? 58
  use the System Log 59
  view system log 59
TSInbox 56
W
Web 63
web 63
Windows
  configure Transfer Station Service Manager 51
Windows XP Professional SP2
  configuration 50
Work area 63
World Wide Web 63
X
XML, Save As 28
U
URL 63
V
View Log 27